



OUR 17TH ANNUAL PICNIC 

FOUNDED MAY 1989 

MEETINGS - SECOND  

  SATURDAY OF THE MONTH

JUNE LOCATION 
JUNE 10TH!   REMEMBER IT’S PICNIC TIME. PICNIC MAP IS ON PAGE 5. 

.

EDITOR COMMENTS 

Glenn Fleishman provides good 
advice on how to find and delete 
large unneeded files. Also how to 
create a Spotlight search and 
store it in a smart folder. 
tinyurl.com/ybl2oqml.


And while you’re at it, you ought 
to consider deleting apps you 
haven’t used for quite a while. 
OSXDaily provides instructions. 
tinyurl.com/ybl2oqml. 


The Health app on your iPhone 
automatically tracks your fitness 
activity (even when you don’t 
know it), but it can also be used 
to record emergency medical 
in format ion which can be 
accessed even from a locked 
iPhone. tinyurl.com/hzhz4a3. 


Sound bars blow away the 
speakers built in flat-panel TVs 
and you can buy them for less 
than $250 with the quality that 
wil l satisfy most l isteners. 
tinyurl.com/yb48py4a.

AT TIMES IMAGES MAY BE A BIT 
FUZZY. THAT’S NORMALLY 
BECAUSE ORIGINAL IMAGES 
WERE FUZZY. IF YOU NEED TO 
READ THEM, PLEASE GO TO THE 
ORIGINAL ARTICLE. 

http://tinyurl.com/ybl2oqm
http://tinyurl.com/ybl2oqml
http://tinyurl.com/hzhz4a3
http://tinyurl.com/yb48py4a
http://tinyurl.com/ybl2oqm
http://tinyurl.com/ybl2oqml
http://tinyurl.com/hzhz4a3
http://tinyurl.com/yb48py4a
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MLMUG Email list


The Main Line Macintosh Users 
Group has its own email list. 
Compose your letter and email it to 
mlmug@yahoogroups.com and 
your message will be sent to 
everyone on the mailing list. 
Posting to this list is restricted to 
MLMUG members. Contact Bob 
Barton if you are a member and 
you are not on the list.

Please observe rules of etiquette. 
See the Yahoo Groups Terms of 
Service. The MLMUG list may be 
used to post Apple/Macintosh-
related items for sale, but any 
solicitation of members through 
the list is forbidden without the 
written consent of a MLMUG 
officer. The list is hosted at Yahoo 
Groups.

New Users SIG


You don’t have to wait a whole month to 
get answers to your basic Mac questions! 
Get together with other members on the 
fourth Saturday (i.e., two weeks after each 
regular meeting) for the Startup Folder Lite.


Many new users have said that they can 
learn much more from face-to-face 
meetings than they do from manuals or 
other sources. That’s what this meeting is 
all about. Go to www.mlmug.org/nusfl.html 
for details.


Macintosh Programming SIG/ 

Philly Mac Programming Group 

The objective of this group is to help 
members become more familiar with the 
c o n c e p t s o f M a c i n t o s h a n d i O S 
programming, i.e., the elements of the 
Macintosh GUI, user interaction, file 
sys tem, e tc . , and the ma in Mac 
programming tools: AppleScript, Java, C, 
and Objective C.


The Philly Mac Programming SIG meets at 
10:30 AM on the first Saturday of each 
month, but usually skips January and July. 
Contact Deivy Petrescu, Chair, for venue 
information. www.phillymacprog.org. The 

Typical Meeting Agenda

9:00 - 9:05: 	 Call to order in main meeting 

room.


9:05 - 10:05: Three Concurrent Special 
Interest Groups (SIGs) convene in 
separate rooms. The three current 
SIGs are:


	 Newer Users- We cover the most 
basic questions you may have about 
your Mac/iDevices and how to use 
them.


	 Multimedia - We discuss using your 
Mac/iDevices and applications for 
photo, video, audio, and print media.


	 OS - We go beyond basics to discuss 
Apple’s current operating systems, 
using your Macs & iDevices, & various 
applications, & have Q&A.


10:05 - 10:15: Continuation of Q&A for all 
attendees.


10:15 - 10:30: Welcome and other business.


10:30 - 11:50: Main Presentation (by a 
member or guest)


11:50 - Noon: Raffles and silent auctions.


Come join some fellow MLMUG members 
for lunch after the meeting at a nearby 
restaurant. 

http://www.mlmug.org/nusfl.html
http://www.phillymacprog.org
mailto:mlmug@yahoogroups.com
mailto:mlmug@yahoogroups.com
http://www.mlmug.org/nusfl.html
http://www.phillymacprog.org
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Membership Information 
Membership dues are $25 for individuals and $35 
for families. Memberships are based on your 
anniversary date, which is the month you joined. 
You will be e-mailed reminders when membership 
fee is due.  
If you’re just visiting to check us out, or if you’ve 
been visiting for some time, but haven’t joined, 
consider these BENEFITS OF MEMBERSHIP:

• Monthly meetings, where you can learn, share, 

and meet everyone f rom work ing Mac 
professionals to new Mac users from all 
backgrounds.


• Monthly newsletter, which is full of interesting 
Mac news, tips, and information.


• Useful free items at the monthly Raffles. 

• Discounts. Vendors offer special prices to User 

Group members.

• Web Site with 12 months of MLMUG 

newsletters, meeting information, a member 
directory, directions to our meetings, and much 
more! Our web site is www.mlmug.org.


• MLMUG Mailing List, to post technical 
questions or comments to each other and the 
experts within the group. 


• Reviewers keep items reviewed.

Are you ready to join? Please make a check 
payable to MLMUG and bring it to a monthly 
meeting or mail it to:


Treasurer, MLMUG

P.O. Box 1374


Southeastern, PA 19399


Newsletter Copy Editor & Apple 
User Group Ambassador 

Deane Lappin

deanezl@verizon.net 

Newer Users SIG Co-Chair & 
Deputy Webmaster 

Bob Barton

barton@bee.net


Newsletter Graphics Editor 
Sally Bazrod


sallybazrod@mac.com

OS/iOS SIG Chair 

Adam Rice

adam@adamrice.org


Raffle Chair 
Susan Czarnecki 

sparsefur@yahoo.com 
Social Secretary 
Gail Montgomery


gailemontgomery@comcast.net

Webmaster 

Deivy Petrescu

mlmug_2004@dicas.com


President, Program Director & 
Vendor Liaison 

Maria O. Arguello

mariarguello@mac.com


Vice President & Multimedia SIG 
Co-Chair 

Larry Campbell

lcampbell9@me.com


Treasurer, Membership & 
Facilities Coordinator 

Elliott Cobin

eicobin@yahoo.com


Secretary & Newsletter Editor 
Mark Bazrod


msb@lpilease.com

Member-at-Large 

Deane Lappin

deanezl@verizon.net

Educational Liaison 

Linda McNeil

mcneil.linda@gmail.com

Multimedia SIG Co-Chair 

Nicholas Iacona

nick@nickiacona.com 
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PICNIC INFORMATION
DIRECTIONS 

Take US 202 North or South to PA 29N/Great Valley. Take 
29N and go approximately 0.5 miles and pull into the turn 

lane for Valley Creek Park. You will have passed part of the 
Great Valley Corporate Center on your right.  There is not a 

light at the turn so if you get to the light at Great Valley 
Parkway, you have gone too far. Once you pull into the lot, 

make a short left and right and park. Then walk down the hill 
to the covered pavilion. 

From US 30 (Lancaster Pike), it’s about 1.2 miles on 29N to 
the Park. 

17TH ANNUAL MLMUG  
PICNIC-IN-THE PARK 

Valley Creek Park  
Route 29, East Whiteland. 

Saturday, June 10, 2017 
12 Noon - 4 PM 
(No Raindate) 

All members and their families are welcome. 

Hamburgers, hot dogs, rolls and condiments 
will be provided by MLMUG. All other food and 

beverages will be brought by attendees. 

We’ll need: snacks, salads (green and main 
dish), desserts and beverages (canned sodas, 

juice, iced tea, etc.). 

No alcoholic beverages in the park!  
Pets are OK, but must be leashed and cleaned 

up after. 

It's important that we have accurate 
numbers, so please RSVP: Gail Montgomery 

by Tuesday, June 6 
gailemontgomery@aol.com

mailto:gailemontgomery@aol.com
mailto:gailemontgomery@aol.com
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Bookmarks 

By Mark Bazrod 

Mossberg’s Last Column 

Walt Mossberg started a weekly column for The Wall Street Journal 
back in 1991, has organized industry conferences, and is one of 
our most influential IT writers. He just published his last column, 
musing on the history and future of computer technology. I thought 
it would be appropriate to note his historic and insightful column. 

Mossberg: The Disappearing Computer  

Tech was once always in your way. Soon, it will be almost invisible. 

Welcome to Mossberg, a weekly commentary and reviews column 
on The Verge and Recode by veteran tech journalist Walt 
Mossberg, executive editor at The Verge and editor at large of 
Recode. 

This is my last weekly column for The Verge and Recode — the 
last weekly column I plan to write anywhere. I’ve been doing these 
almost every week since 1991, starting at The Wall Street Journal, 
and during that time, I’ve been fortunate enough to get to know 
the makers of the tech revolution, and to ruminate — and 

sometimes to fulminate — about their creations. 

Now, as I prepare to retire at the end of that very long and world-
changing stretch, it seems appropriate to ponder the sweep of 
consumer technology in that period, and what we can expect next. 

Let me start by revising the oft-quoted first line of my first Personal 
Technology column in the Journal on October 17, 1991: “Personal 
computers are just too hard to use, and it’s not your fault.” It was 
true then, and for many, many years thereafter. Not only were the 
interfaces confusing, but most tech products demanded frequent 
tweaking and fixing of a type that required more technical skill than 
most people had, or cared to acquire. The whole field was new, 
and engineers weren’t designing products for normal people who 
had other talents and interests. 


 Dow Jones  Walt Mossberg’s “Personal Technology” debut in 1991.  
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But, over time, the products have gotten more reliable and easier 
to use, and the users more sophisticated. You can now hand an 
iPad to a six-year-old and, with just a bit of help, she will very likely 
learn how to operate it quickly. That’s amazing, given that the iPad 
is far more powerful than any complex PC I was testing in the 
1990s. Plus, today’s hardware and software rarely fails 
catastrophically like PCs did so often in the old days. 


So, now, I’d say: “Personal technology is usually pretty easy to 
use, and, if it’s not, it’s not your fault.” The devices we've come to 
rely on, like PCs and phones, aren't new anymore. They're refined, 
built with regular users in mind, and they get better each year. 


Anything really new is still too close to the engineers to be simple 
or reliable. Many people aren’t going to be able to hook up a 
dedicated virtual reality system, or want to wear the headset. And 
most of us can’t yet trust Siri, Alexa, or Google Assistant for an 
accurate, useful answer much of the time. But it’s early days for 
those technologies. 


So: where are we now, and what’s coming? 


The lull  
As I write this, the personal tech world is bursting with possibility, 
but few new blockbuster, game-changing products are hitting the 
mainstream. So a strange kind of lull has set in. 


The multi-touch smartphone, launched 10 years ago with Apple’s 
first iPhone, has conquered the world, and it’s not done getting 
better. It has, in fact, become the new personal computer. But it’s a 
maturing product that I doubt has huge improvements ahead of it. 
Tablets rose like a rocket, but have struggled to find an essential 
place in many people's’ lives. Desktops and laptops have become 
table stakes, part of the furniture. 


The big software revolutions, like cloud computing, search 
engines, and social networks, are also still growing and improving, 
but have become largely established. 


Consumer drones and robotics are in their infancy, a niche, with 

too few practical uses as yet. 


The biggest hardware and 
software arrival since the iPad 
in 2010 has been Amazon’s 
E c h o v o i c e - c o n t r o l l e d 
intelligent speaker, powered 
b y i t s A l e x a s o f t w a r e 
assistant. It arrived in 2015, 
and was followed last year by 
the similar Google Home 
device. I expect others. 


But the Echo and Alexa are just getting started. Amazon CEO Jeff 
Bezos told me in an interview last year that artificial intelligence 
was not just in the first inning of a long baseball game, but at the 
stage where the very first batter comes up. And, while Amazon 
doesn’t release sales figures for the Echo family, third-party 
estimates say that, while they are growing fast, they were still well 
below 10 million units last year. For comparison, even in a 
relatively weak period, Apple sold 50 million much costlier iPhones 
in just 90 days last quarter, and the combined total sales of the far 
more prevalent Android phones no doubt were much greater. 


Google just announced that there are now 2 billion Android 
devices in active monthly use globally, and Apple announced a 
year and a half ago that there were over 1 billion iOS devices in 
active use. These are mostly smartphones, and they are no longer 
novel. 


Wait for it  
But just because you’re not seeing amazing new consumer tech 
products on Amazon, in the app stores, or at the Apple Store or 
Best Buy, that doesn’t mean the tech revolution is stuck, or 
stopped. In fact, it’s just pausing to conquer some major new 
territory. And, if it succeeds, the results could be as big or bigger 
than the first consumer PCs were in the 1970s, or even the web in 
the 1990s and smartphones in the first decade of this century. 
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All of the major tech players, companies from other industries, and 
startups whose names we don’t know yet are working away on 
some or all of the new major building blocks of the future. They 
are: artificial intelligence / machine learning, augmented reality, 
virtual reality, robotics and drones, smart homes, self-driving cars, 
and digital health / wearables. 


All of these things have dependencies in common. They include 
greater and more distributed computing power, new sensors, 
better networks, smarter voice and visual recognition, and 
software that’s simultaneously more intelligent and more secure. 


Examples of all these technologies already exist, but they are early, 
limited, and mainly attractive to enthusiasts. Compared to what’s 
coming, they are like the Commodore PET (look it up, kids) or 
those huge car phones in old movies. 


Ambient Computing  
I expect that one end result of all this work will be that the 
technology, the computer inside all these things, will fade into the 
background. In some cases, it may entirely disappear, waiting to 
be activated by a voice command, a person entering the room, a 

change in blood chemistry, a shift in temperature, a motion. Maybe 
even just a thought. 


Your whole home, office and car will be packed with these waiting 
computers and sensors. But they won’t be in your way, or perhaps 
even distinguishable as tech devices. 


This is ambient computing, the transformation of the environment 
all around us with intelligence and capabilities that don’t seem to 
be there at all. 


It reminds me of a great Saturday Night Liveskit, from 2005, where 
cast member Fred Armisen, playing Steve Jobs, shows off an ever-
smaller series of iPods, finally producing a model that’s literally 
invisible, yet holds “every photograph ever taken.” 


Just in recent weeks, Facebook’s famed researcher Regina Dugan 
has announced that her secretive team is working on using the 
brain to type, and to control augmented reality devices. They are 
also developing ways to “hear” through your skin. 


Their idea is that, even if augmented reality gets built into standard 
eyeglasses and can impose sophisticated virtual objects onto real 
life, it won’t be seamless if you have to push buttons, use touch 
controls or utter commands. 


Apple reportedly has a secret project to monitor the glucose levels 
of diabetics with new non-invasive sensors, ending the need for 
daily test needles. 


Google has changed its entire corporate mission to be “AI first” 
and, with Google Home and Google Assistant, to perform tasks via 
voice commands and eventually hold real, unstructured 
conversations. 


Several small firms are pursuing the prospect of recharging mobile 
devices with power sent through the air, so power cords won’t be 
around. 


I expect to see much of this new ambient computing world appear 
within 10 years, and all of it appear within 20. 
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Why it matters  
Every one of these efforts has the potential to create a new world 
that’s unrecognizable. It’s a radically different way of thinking 
about tech. 


When the internet first arrived, it was a discrete activity you 
performed on a discrete hunk of metal and plastic called a PC, 
using a discrete software program called a browser. Even now, 
though the net is like the electrical grid, powering many things, you 
still use a discrete device — a smartphone, say — to access it. 
Sure, you can summon some internet smarts through an Echo, but 
there’s still a device there, and you still have to know the magic 
words to say. We are a long way from the invisible, omnipresent 
computer in the Starship Enterprise. 


Worse, those early computers were in your way. They were hulking 
objects that demanded space and skill. Even now, if you look 
around a restaurant, you’ll see smartphones on the tables, waiting 
to be used. 


Computers have gotten vastly easier to use, but they still demand 
attention and care, from charging batteries to knowing which apps 
to use and when to use them. 


Technology has been a great thing, but it’s been too unnatural, an 
add-on to life, for 40 years. What’s going on in the labs has the 
promise to change that. 


The dark side  
Some of you who’ve gotten this far are already recoiling at the idea 
of ambient computing. You're focused on the prospects for 
invasion of privacy, for monetizing even more of your life, for 
government snooping and for even worse hacking than exists 
today. If the FBI can threaten a huge company like Apple over an 
iPhone passcode, what are your odds of protecting your future 
tech-dependent environment from government intrusion? If British 
hospitals have to shut down due to a ransomware attack, can 
online crooks lock you out of your house, office or car? 


Good questions. 


My best answer is that, if we are really going to turn over our 
homes, our cars, our health and more to private tech companies, 
on a scale never imagined, we need much, much stronger 
standards for security and privacy than now exist. Especially in the 
U.S., it’s time to stop dancing around the privacy and security 
issues and pass real, binding laws. 


But, as tectonic shifts like this occur in technology, oligopolies get 
shaken up. 


And, if ambient technology is to become as integrated into our 
lives as previous technological revolutions like wood joists, steel 
beams and engine blocks, we need to subject it to the digital 
equivalent of enforceable building codes and auto safety 
standards. Nothing less will do. And health? The current medical 
device standards will have to be even tougher, while still allowing 
for innovation. 


The tech industry, which has long styled itself as disruptors, will 
need to work hand in hand with government to craft these policies. 
And that might be a bigger challenge than developing the 
technology in the first place. 


The oligopoly  
Most of the work on this, especially what we and others can learn 
about and report about, is coming from the giant companies that 
make up today’s tech oligopoly — Apple, Amazon, Facebook, 
Google and Microsoft. 


But, as tectonic shifts like this occur in technology, oligopolies get 
shaken up. For instance: today, Apple is the biggest of the group. 
By all reports, it’s working seriously on AR, self-driving cars, and 
health initiatives. But its strict and admirable privacy policies make 
it harder for it to gather the vast amounts of data required for the 
best machine learning. 


Microsoft is still trying to find a way to meld its formidable software 
and cloud expertise with a significant hardware business. The ad-
based business models of Facebook and Google, now so 
dominant, could prove fickle. And Amazon has only had one really 
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giant hardware hit — the Kindle — in its existence. 


But, even if these oligarchs all do fine, and their ranks swell by one 
or two, the country and the world will have to ask if they have too 
much power — and, if so, how to curb it without killing progress. 


The bottom line  
We’ve all had a hell of a ride for last few decades, no matter when 
you got on the roller coaster. It’s been exciting, enriching, 
transformative. But it’s also been about objects and processes.  

Soon, after a brief slowdown, the roller coaster will be accelerating 
faster than ever, only this time it’ll be about actual experiences, 
with much less emphasis on the way those experiences get made. 


As a gadget-lover, this makes me a little sad. But, as a tech 
believer, it’s tremendously exciting. I won’t be reviewing all the new 
stuff anymore, but you can bet I’ll be closely watching this next 
turn of the wheel. 


Thanks for reading. Mossberg out. 
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Oscar Raymundo posted the following article to macworld.com on 
May 19, 2017. tinyurl.com/lrn76e6. © Mac Publishing.LLC. A staff 
writer for Macworld, he has written for Wired, National Geographic, 
Rolling Stone and Refinery29. He is currently working on his first 
novel. 

Tim Cook is testing a new Apple Watch device that 
monitors his blood sugar levels 
Apple wants to develop the "holy grail" in diabetes: non-invasive, 
continuous glucose monitoring. 

By Oscar Raymundo  

Tim Cook is not only acting CEO at Apple, but he’s also one of its 
beta testers.


This week, CNBC reported that Cook has been testing a new 
device that monitors his blood sugar levels. This glucose monitor 
is a prototype attached to Cook’s Apple Watch that can track how 
food consumption and exercise affects the CEO’s blood sugar 
levels.


Back in February, Cook told students at the University of Glasgow 
that he had been continuously wearing a glucose monitor, but did 

not confirm it whether it was an Apple prototype.


[ Further reading: The best DVRs for cord cutters ]


“It’s mentally anguishing to stick yourself many times a day to 
check your blood sugar.”


“It’s mentally anguishing to stick yourself many times a day to 
check your blood sugar,” Cook said. “There is lots of hope out 
there that if someone has constant knowledge of what they’re 
eating, they can instantly know what causes the response... and 
that they can adjust well before they become diabetic.”


Apple has been very interested in developing what it calls the “holy 
grail” in diabetes:  non-invasive, continuous glucose monitoring. 
Last month, it was reported that Apple has had a team of 
biomedical engineers working on this very project for five years. If 
successful, these sensors would be able to monitor blood sugar 
levels without breaking the skin.


According to CNBC, Apple is currently conducting feasibility trials 
in clinics near Cupertino. And the company has also reportedly 
been in conversations with consultants to figure out “regulatory 
pathways.”


Why this matters:  If Apple is successful in creating this next-gen 
glucose monitor, it would transform the Apple Watch from a 
wearable accessory to a revolutionary health device. Even though 
the Watch can now monitor your heart rate and track your activity, 
it’s obvious Apple wants to add more significant health 
applications.
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Emily Price posted the following article to lifewire.com on March 
20, 2017. tinyurl.com/ycgzkkho. © About, Inc. She has has been 
writing about tech for the web for over a decade. Her work has 
appeared in countless publications, including PC World, Reuters 
and the The Wall Street Journal.


Apple Watch has 'Enormous' Potential For Healthcare 

 

By Emily Price  
It looks like the Apple Watch might eventually have a lot more 
health features baked in.   Speaking at Startup Fest Europe this 
week in Amsterdam, Cook said that he thought that the Apple 
Watch had “enormous” potential when it comes to healthcare, and 
could ultimately be used as a warning system of sorts for health 
problems, similar to how the check engine light works in your car. 
That way you might know something is wrong before you ever 
experience any physical symptoms. 


"If you think about some of society's biggest problems and 
challenges, one of the ones that we are really focused on is 
health,” CNBC reports Cook saying at the conference. "And 
arguably the health care system can be made much simpler, can 
have much better results, you can have patients that really feel like 

customers...and have systems and applications that bring out the 
best in the medical professionals...I think the runway there is 


enormous.” 


He goes on to talk about how much he enjoys using the Apple 
Watch, and how he feels the device might one day become even 
more common. 


"I love the watch. One day, this is my prediction, we will look back 
and we will wonder: how can I ever have gone without the 
Watch?,” Cook said. “Because the holy grail of the watch is being 
able to monitor more and more of what's going on in the body. It's 
not technologically possible to do it today to the extent that we 
can imagine, but it will be,” 


Healthcare is certainly something that Apple is becoming more 
and more passionate about. 


Apple has also recently published a job listing on its site, searching 
for a lawyer that specializes in health privacy regulations. The job, 
which will be based in Apple’s Santa Clara office is for someone to 
work directly with the company’s business and engineering teams 
to design new privacy solutions for products, as well as work with 
Apple’s legal department on regulatory issues and other Apple 
activities. 


“At Apple, we are about creating great products. Part of making 
products great is designing products that respect consumer 
security and privacy,” reads the ad. “This role offers the 
opportunity to work directly with key members of the business, 
engineering and legal teams on a variety of cutting-edge projects 
including privacy by design reviews and projects   assist with 
privacy complaints and breaches   support compliance and 
auditing frameworks   advise on privacy aspects of licensing and 
procurement deals and corporate acquisitions   assist with drafting 
of policies and procedures surrounding privacy laws.”  


Already in Use 
The Apple Watch is already being used as a warning system of 
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sorts in some tests. 


An app called Epi Watch being tested at Johns Hopkins University 
School of Medicine, has patients take daily surveys and make 
journal entries about their disease and tries to get them to 
document when they have seizures and what happens to their 
body prior to one come on. Thanks to the Apple Watch’s   heart 
rate monitor, accelerometer, and gyroscope, researchers are able 
to track changes in heart rate as well as body movement in 
patients, ultimately gaining a better understanding of the disease. 


The hope is by tracking exactly what’s happening to patients 
before they have a seizure, researchers will be able to determine 
exactly what happens in the moments before, and potentially 
warm patients a seizure is coming on. For someone with epilepsy, 
that knowledge could be exceptionally powerful and dramatically 
improve their quality of life. 


"We foresee the app giving some parents the confidence to allow 
their children to play on their own," said Gregory Krauss, professor 
of neurology at the Johns Hopkins University School of Medicine 
in a statement on the university’s Hub. "For some adults, using it 
might allow them, for the first time, to live safely alone.” 


Cancer patients in Camden, New Jersey are also using the Apple 
Watch as part of their cancer treatment. While the watch has very 
little to do with their treatment physically, wearing the Apple Watch 
allows doctors to monitor a patient’s condition while they’re at 
home. That means that a doctor can tell exactly how a particular 
treatment affected a patient, without requiring him or her to be 
under constant observation in a hospital environment. For 
instance, a doctor might be able to see that a person’s heart rate 
was elevated after a particular type of treatment, or that something 
made him or her more sedentary than usual. The app is also used 
to monitor patient’s moods, by asking them a few questions about 
their general mental state each day. 


“The app allows us to stay in touch with our patients while they’re 
in care at home and in the hospital by measuring their physical 
condition through the watch and their mental condition through a 

series of questions that we ask so we can get a more holistic view 
of their health,” Mark Anthony, CEO of Polaris Health, told 
FOXBusiness. 


Smart Bands 
Those potential healthcare possibilities don’t have to be restricted 
to the Apple Watch body. Earlier this year, a third-party 
manufacturer called Kardia unveiled the Kardia Band, an Apple 
Watch band that works as a medical-grade EKG reader.  


“Kardia Band for Apple Watch represents both the future of 
proactive heart health and the introduction of the Wearable 
MedTech category,” said Vic Gundotra, chief executive officer of 
AliveCor. “These combined technologies give us the ability to 
deliver personal reports that provide analysis, insights and 
actionable advice for the patient and their doctor.” 


Gundora’s name might sound familiar. He previously worked at 
Google as the head of Google+. He joined the company behind 
the band, AliveCor, in November of last year.  


And then Apple itself has been rumored to be working on its own 
"Smart Bands" for the Apple Watch.  The bands are rumored to 
connect to the smart port on the existing Apple Watch and will be 
able to monitor things like Blood pressure, blood oxygen, body 
temperature, and respiratory rate. The bands were initially rumored 
to be coming at the beginning of 2016. While that didn’t happen, 
there’s still the possibility that we’ll see smart bands come during 
Apple’s annual Worldwide Developer’s Conference (WWDC) in 
June. 


Health Tracking 
As it stands, the Apple Watch is already a fairly powerful health 
tool. the device can monitor your movement as well as your heart 
rate and can do things like track particular workouts, reporting 
back your calorie burn for those activities. 


The Workout functionality in the Apple Watch is a feature that I’ve 
particularly enjoyed about the wearable. Each week, the Apple 
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Watch suggests workout goals based on what you were able to 
accomplish the previous week. It may sound like a small thing, but 
being able to gradually increase your workout/calorie burn week or 
week was exceptionally helpful for me, and allowed me to 
essentially triple a number of calories I was burning with each 
workout, without actually realizing I was increasing it. 


That gradual increase is key, that way you’re not starting out with 
too high of a goal, and then becoming frustrated when you aren’t 
able to meet it. I also really enjoy the Apple Watch’s standing 
reminders. Also a small thing, but when you work at a job that 
keeps you confined to your desk all day, a small reminder 
suggesting that you get up and take a walk around the room for a 
minute can go a long way, and ultimately make you a ton healthier 
over time. 


A New Apple Watch 
One thing we definitely expect to see at WWDC: a new Apple 
Watch. 


There have been quite a few rumors in recent months about the 
next-generation of the Apple Watch, a device that is expected to 
make its debut on stage at WWDC in June. Amongst other 
features, the device is expected to potentially have cell 
connectivity. That means that you’ll be able to use it even when 
your iPhone isn’t around. 


Other updates expected to come with the next generation of the 
watch include a thinner design, longer-life battery, as well as be a 
bit more durable than the current version. The newest version of 
the Apple Watch is also rumored to have a built-in FaceTime 
camera, enabling you to video chat with friends without having to 
pull out your phone or computer in order to do so. 


The newest version of the Apple Watch is also expected to be a 
popular one, perhaps pulling in more sales than the previous 
version. 


According to a recent survey,  two thirds of current Apple Watch 
owners plan on upgrading to the newest version of the Apple 

Watch when it is released to the public, even though they currently 
have no idea when that will be, or what improvements might come 
to the device. That same survey asked those who had yet to 
purchase a smartwatch what was keeping them from making the 
purchase. By in large, those customers indicated that price was 
the main barrier to them deciding to buy, even after the recent 
price drop for the Apple Watch. 


Earlier this year, Apple dropped the entry price for the Apple Watch 
by $50, a move that many felt was designed to increase sales 
before the company introduced a new version of the device. 
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MLMUG May 13, 2017 Meeting Minutes 
By Mark Bazrod, Secretary 
Maria Arguello, our President, opened the MLMUG meeting at 9:15 
AM at the Hershey’s Mill Community Center near West Chester. 
There were about 50 attendees. 
Mike Inskeep (mike@gentlehelpers.com) gave a outstanding 
presentation on security for your Mac. Everyone should not only 
read these minutes, but should download the PDF of his 
presentation which is on the MLMUG website (http:// 
www.mlmug.org/pdfs/Secure_Your_Mac_2017.pdf) because you 
need to immediately start making changes in your Mac and in your 
procedures. His presentation is the place to start. 
The basic approach is to identify threats & prevent them by 
removing or limiting the vulnerabilities they rely on. Change how 
your Mac is set up, change your standard operating procedures, 
slow down in risky situations, and plan for worst-case scenarios. 

Principles of Digital Security 
Have robust and redundant data storage. 
Build layers of security. 
Keep the operating system and apps up to date. Minimize attack surface. 
Limit permissions. 
Use passwords and two-factor authentication. Pay for what you use. 

Minimize Network Attacks 
The threats: gateway/router take-over. (e.g. the Mirai Botnet); 
rogue access points (e.g. the Wifi Pineapple which impersonates 
the hardware broadcasting the network you want to connect to so 
it can see everything you send and receive); gaining “Privileged 
network position” (the malware attacker gets on your local 
network). 
Determine your router IP (numerical) address so you can change 
items. Go to:  >System Preferences > Network The IP address 
for your Mac will be shown as four numbers separated by periods, 
e.g. 10.0.0.8. Replace the last number with 1 to get the router 

address (in this case 10.0.0.1). Launch browser, enter the 
numerical IP address, enter user name and password (probably 
admin and password). Change the password, the user name (if 
possible), the wireless network name (if you wish), disable remote 
administration, and enable automatically update firmware. 
[Editor - I have a Linksys router which has a given network address 
of 192.168.1.1. Routers by other manufacturers have different 
addresses. I went to http://192.168.1.1, entered the admin 
password found on the router, changed the names of the two 
networks (2.4 GHz and 5 GHz), and entered a strong password. I 
then had to enter the new network name and password on all the 
devices in the house.] 
If you have a gateway (combination modem/router) from your 
Internet service provider (e.g. Comcast or Verizon), install your own 
router so you will add another wall to your defenses. Apple is 
discontinuing Airport routers. You should review Dave Hamilton’s 
presentation in the April minutes and recent online reviews before 
buying a new router. A Cat 5e or 6 cable connection is faster then 
a wireless connection. Change the router’s administrator user 
name if possible and set a new strong password. Put them on a 
note on the router. 
Change settings on your Mac to make it more resistant to network 
attacks.  > System Preferences > Network. Unlock, select Ask to 
join new networks and Show Wi-Fi status in menu bar, and click on 
Advanced. Delete unused networks, particularly if no security, drag 
to arrange in order of preference, and click on Remember 
networks this computer has joined. In Require administration 
authorization section, enable Create computer-to- computer 
networks and Change network. Click on the Proxies tab at the top. 
Uncheck everything except Use Passive FTP Mode. 
 > System Preferences > Sharing. Give bogus name to your 
computer. You don't need printer sharing any more. 
 > System Preferences > Security & Privacy > Firewall. Turn on. 
Unclick the lock. Go to Firewall options. Allow or block by 
application. Click Enable stealth mode so not echo pings back. If 
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you turn off SSID (network name), others will not not see your 
network. 
 > System Preferences > Bluetooth. Click on Show Bluetooth in 
menu bar so easy to turn Bluetooth off or on and see when 
connected. 

Subscribe To A VPN 
You should subscribe to a VPN(virtual private network). This will 
encode what you send to servers and protect you against man in 
middle attacks. Mike uses Private Internet Access. $40 year. Don't 
trust free VPN. 
You should read reviews for VPNs. There are thousands. Nearly all 
online VPN reviews receive compensation for referrals. For unbiased 
reviews of VPNs, Mike recommends thatoneprivacysite.net & 
pcmag.com/ article2/0,2817,2403388,00.asp. 

Network Practices 
You should change your network practices. If you are not using 
Wi-Fi or Bluetooth, turn them off. When you are traveling, put your 
laptop to sleep or shut down when not using. When you are using 
a public network, only use it to read or view. Do not do anything 
active such as buying, moving money, signing into accounts for 
checking email, sending or receiving texts. If you must do one of 
these, use your cellphone with Wi-Fi turned off. 

Scan For Malware 
KnockKnock. It’s a free program. It checks for persistently installed 
items and then checks with VirusTotal, to identify malware. Doesn't 
list Apple signed apps by default. Best antivirus scanner. Doesn’t 
run all the time. 
Dylib Hijack Scanner. This tool scans for apps were opened using 
resources stored in a fixed place in memory which makes them 
vulnerable to attack. This was fixed by Sierra. 
In answer to a question, Mike said Malwarebytes identifies 
malware by snippets of code. However, if the malware is 
“packed” (using UPX for example) or encrypted, this technique will 

not work. Even if it’s not packed or encrypted, Malwarebytes can 
only catches if known malware. [Editor - If you want to know more, 
google packers malware.] 

Data Storage 
Backup is essential. You should backup for protection in the event 
of mechanical failure, to revert to a prior state if an update causes 
problems, recover from a malware infection, restore damaged or 
lost items, or restore a previous version of a file (e.g. document, 
photo). 
Good backups are automatic, reliable, not always connected, and 
in multiple locations, including one offsite. 
Time Machine supports multiple drives, directly connected drives 
(e.g. USB, Firewire, Thunderbolt), and networked drives. It retains 
different versions of the same item. Time Capsule is not always 
attached so ransomware can not hit it. An alternative is to use and 
swap multiple drives. 
A clone duplicates the internal hard drive so you can boot from it 
and be up and running immediately. Carbon Copy Cloner or 
Superduper are excellent for this. 
iCloud can sync your data, including contacts, photos and docs, 
with Apple’s computers. iCloud is like a clone, but sync goes both 
ways.No versioning in iCloud. 

Backup Suggestions 
For local hard drives Mike recommends HGST Touro USB 3.0 
drives. A little more expensive, but worth it. Also, Toshiba Canvio 
drives. USB 3.0 is backward compatible to USB 2.0. 
For online storage, he recommends CrashPlan. It is relatively 
inexpensive. $60 year. Reliable. Unlimited cloud storage. Not a 
resource hog. Very strong encryption. In beginning, it could take 
3-4 days to backup all files. 

Backup Maintenance 
Regularly (weekly) test your backups. Put it on your calendar. 
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Restore a couple files. 
Monthly run Disk Utility First Aid on your backups to test the 
integrity of the drive. It checks the table of contents with what is 
actually on the drive. If not OK, reformat the disk and start over. 
Put it on your calendar. 

Accounts 
When you are working, use a standard account, not an 
administrator account. 
First create an administrator account with an unusual name and a 
strong password.  > System Preferences > Users & Groups 
To demote your current account to a standard account, login to 
the administrator account, then in  > System Preferences > 
Users & Groups, uncheck Allow user to administer this computer. 
Have a strong password for your standard account [Editor - at 
least 12 characters]. 
Have a guest user account for visitors which will not have access 
to your files. Remove outdated login items. 
Remove outdated login items. 

Operating System 
Keep your operating system up to date. 
Sierra patched 65 security vulnerabilities. Most prevent arbitrary 
code execution by bad guys. Application path randomization 
prevents dynamic library hijacks. Dropped old insecure protocols. 
Safari 10, bundled with Sierra, fixed 21 security vulnerabilities. 

OS Updates and Upgrades 
Free. 
Backup before you install an upgrade or update. 
Often add new features. 
Wait for 10.x.1 bug fix before you install a new upgrade, such as Sierra. 
Upgrade to most recent version which your hardware supports. 

Install updates as soon as possible.


APFS Coming 
APFS, the new file system, is expected later this year as an update 
to 10.12. 
All Apple operating systems (macOS, iOS, tvOS, watchOS) will 
have same file system. This means better syncing between 
devices, native encryption. snapshots (better versioning), instant 
writable clones (more reliable and efficient backup). 

Application Security. 
Remove (uninstall) unused apps because they have a door into 
your Mac. 
Read reviews before you install an app. 
Apply updates soon as available. 

Where To Get Apps 
Safest place is the App Store. Next is the developer’s website with 
https connection. Then reputable retailers such as Amazon, B&H 
Photo or highly rated eBay vendors. Do NOT go to download.com 
or macupdate.com. 

App Settings 
 > System Preferences > App Store 
Allow automatic updates. It will still ask your permission to install 
upgrades. 
You have choice of time of installation if the update requires your 
Mac to restart. 
 > System Preferences > Security & Privacy 
Only allow apps if you purchase thru App Store. 
When you attempt install a new app not purchased through the 
App Store, it will initially decline. Go to  > System Preferences > 
Security & Privacy, tap the button to allow it to install, then enter 
your administrator user name and password. 
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SECURITY! 
The time for complacence about Mac security is over. We are 
seeing more scary malware attacking Macs. There were 6 Mac
malware items released in 2016. There have been 7 already 
released this year. 
Traditional antivirus programs can't detect new malware so some 
suggested apps to install are: 
Ransomwhere? stops ransomware by detecting processes that are 
encrypting your personal files, stops the process and presents an 
alert to the user. 
KnocKnock checks to see if software is persistently installed which 
may indicate a problem. It asks you to allow or deny the process. 
KnocKnock checks with the VirusTotal web site to see if the 
software contains known malware code. 
F-Secure XFENCE (was Little Flocker) is a more comprehensive 
alternative to installing Ransomware and KnocKnock, but requires 
more intervention on the user’s part. It observes every time an app 
tries to open, write, execute, or otherwise modify any file or folder, 
and lets you set rules. Asks you to set one-time, short-term, or 
permanent exceptions. In Beta. 
Little Snitch does the same for network processes. 
You should uninstall flash. It has tons of vulnerabilities and new 
ones keep being discovered. Flash components are located in 
Macintosh Hard Drive >Library> Internet Plug Ins. Drag them to the trash. 
If you must view a website which uses flash, use Chrome where 
flash is an integral part of the app and flash contents are 
sandboxed. The best route would be to not run flash at all. 
Firefox is the browser he uses most of the time with 4 extensions. 
Ublock Origin is the best ad blocker and site tracker. Adblock is 
reputed to be subservient to the ad industry. 
Ghostery detects and blocks tracking technologies to speed up 
page loads, eliminate clutter, and protect your data. 

Random Agent Spoofer aims to hinder browser fingerprinting. It 
does this by changing the browser/device profile on a timer. Mike 
has it set to change every 5 minutes and tell the web server that it 
is a Windows browser. Windows malware will not run on a Mac. 
NoScript blocks scripts, including JavaScript. You have the option 
to allow scripts by the domain they originate from (e.g. when 
reading the NY Times, allow from nytimes.com, but not from 
google.com). 
If you need to log into a web site, particularly if it has sensitive 
content, use your Safari Browser with https. Only use Safari for 
these sites. Do not use it for anything else, including browsing or 
searching. Delete all bookmarks, except the sites you will log into. 
Your browser can't tell if your Mac is infected. If a webpage claims 
your Mac has malware or a virus, it is a scam. Do NOT call any 
Apple support number displayed. 
The actual Apple support phone number is 800.275.2273. Better 
yet, download the Apple Support app from the Apple Store. Apple 
will respond to your question faster than calling a support line. 

Phishing Emails 
Be cautious about opening attachment and links. If you see 
attachments or links, slow down. Hover your cursor over the 
sender name to see if the sending address is the address of the 
person you think. Or compose a new email to the sender asking if 
he sent it. The longer the link ,the more suspicious. Open Word 
docs in Pages. Pages will not run Word macros. 
Use Quick Look to look at a document. It will not launch Preview. 
Don't use webmail because a browser is designed to run scripts - which 
could be malware. Mail will display formatting; it will not run scripts. 

What Security Requires 
Takes effort, but it’s worth it. Often means accepting less 
convenience. Being thoughtful and paying attention. Keeping up 
with security issues. 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Kif Leswing posted the following article to businessinsider.com on 
May 8, 2017. tinyurl.com/y7ejsjv9. © Business Insider, Inc. He is a 
reporter at Business Insider covering Apple and the technology 
industry.  

The New iPad Review: This Is The Best Couch 
Computer Ever 
By Kif Leswing 

The last time I bought an iPad was 2012. It was a good iPad. But 
increasingly — especially when the iPhone 6 came out with a 
bigger screen — I found that my iPad started gathering dust.


The bigger iPhone could do all the same things as my iPad, and as 
my iPad's hardware got older — it still used Apple's old-style 
charger — I stopped using it.


But Apple's newest iPad reminded me that for iPhone users, a big 
tablet that does the same things can be a huge luxury. Browsing 

the web, playing games, and checking social media is all more 
pleasant with a bigger screen.


So a few weeks ago, I bought Apple's newest iPad. Apple just 
calls it iPad, but you might have better luck Googling "2017 iPad" 
or "iPad fifth generation."


Ultimately, it's not that much different than the other iPads sold 
over the past two years, except for one thing: It's cheap, or at least 
less expensive than what previous iPads cost. I paid $329 for 
mine.


But I couldn't be happier with my purchase. It can't do anything 
new compared with other iPads, but it's a great value, and it's 
clear Apple has refined the iPad over the past seven years to be a 
great tablet for most people.


I don't use my new iPad for anything productive. I mostly use it for 
content consumption, and it almost never leaves my house. And 
after using it for the past six weeks, I'm confident it's the best 
couch computer ever.


Here's what I do on my iPad 
• I surf the web. Mobile Safari, the iPad's built-in browser, is 

awesome, stable, and fast, and there aren't many websites the 
iPad can't handle.


• I play games. I've been 
exploring a large number of 
games available on Apple's 
App Store, and there is a 
surprising amount of deep 
games you could pour 20 or 
more hours into. I've been 
playing "Crashlands" lately.


• I watch videos. I've been 
using my iPad to keep up 
with Nationals games on MLB At Bat while my roommates watch 
what they want on TV. I've also watched HBO, Netflix, and other 
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streaming services on the iPad's sharp 9.7-inch screen. It's 
pretty engrossing, especially with headphones.


• I check social media. If there's one issue I have with Apple's 
iPad in general, it's that there isn't Instagram or Snapchat for 
iPad. That said, it's a perfect device to catch up with most of my 
social feeds, including Facebook and Twitter.


• I iMessage my friends. Texting from an iPad is difficult, but if 
your contacts use iMessage, it's easy to send them notes and 
stuff from the iPad.


Here's what I don't do on my iPad: anything resembling 
productivity. I set up my various email accounts on the device, but 
I turned notifications off, and I don't really check or send emails on 
the iPad. I can handle quick notes from my iPhone, and if I need to 
do any word processing or work, I'll boot up my Mac.


Design 
This iPad's design is not going to surprise you. It's a rectangle, 
centered on a beautiful, dense, high-pixel screen. 

I hadn't used a 9.7-inch iPad on a regular basis since 2012, and I 
immediately noticed two things about this new iPad. First, it's light 
enough to use for long stretches of time — something I didn't find 
with my older, heavier iPad. 

Second, there's no physical mute switch. You'll have to turn the 
sound off on the touchscreen or hold the "volume down" rocker 
until it goes silent. 

Finally, all of Apple's new iPads, including the 2017 model, come 
with a fingerprint sensor. While the sensor is less useful on the 
iPad than on the iPhone, it can still be handy, especially if you plan 
to share your tablet with your family — just give everyone a 
fingerprint password.


Battery life 
Apple says this iPad can manage 10 hours of battery life, and I 
believe it. I haven't timed how long it takes this iPad to run out of 

battery, but it doesn't seem to lose charge from day to day when 
I'm not using it, and it can last an entire afternoon gaming. I 
haven't ever had an issue where the iPad ran out of battery and I 
needed to charge it. 

For my use, the battery life is just good enough — it's unclear 
whether an improvement would make the iPad significantly better. 

Which iPad should I get? 

I got the $329 model of the new iPad in space gray because I 
prefer the black border around the tablet's screen. It comes in gold 
and silver as well, but those come with a white bezel on the front.


The entry-level model has 32 GB of space, which is more than 
enough for me because I'm not uploading videos or music onto 
my tablet. So far, it's plenty of storage space for me, and unless 
you know you use a lot of space, it probably will be for you, too.


After a month of heavy use, I still have over 15 GB available. 

e iPad without connecting to a Wi-Fi network. Of course, the cell 
service requires a monthly fee. Since I use my iPad at home, 
connected to Wi-Fi, I didn't need it — so I saved the money.


Should you buy it? 
For nearly everybody, Apple's newest iPad is the best value if you 
know you want an iPad. 

You might want to upgrade to the 9.7-inch iPad Pro if you like the 
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size and shape but want to be able to use Apple's stylus, the 
Pencil. The 9.7-inch Pro also has a slightly better screen, 
speakers, and camera, but for my usage, it's not a huge upgrade, 
and since it's $599 from the Apple Store, it's not worth the $270 
extra for me. The more expensive Pro also works with Apple's 
keyboard case, but there are plenty of third-party options for the 
less expensive model. 

The bigger Pro is the most expensive and heaviest iPad model. I 
used a review unit provided by Apple for a few months before I 
bought my iPad. My advice is that if you use it for media 
consumption, as I do, it's not the best option. Not only is it more 
expensive, the ergonomics as a couch computer don't work that 
well — it's heavy and feels oversized. Only get this one if you're 
sure you want to use an iPad as a laptop replacement.


The iPad Mini starts at $400, and its screen is the same resolution 
as the 9.7-inch iPads. It's more expensive than the latest iPad, and 
it has a slower chip. I wouldn't recommend it unless you're sure 
you like the smaller tablet size. It doesn't support the Apple Pencil.


If you don't fit into one of these categories, I'd recommend Apple's 
latest iPad. Apple's pricing the tablet aggressively, and it's a better 
value for most people than anything else in Apple's tablet lineup.


Jim Tanous posted the following article to macobserver.com on 
September 13, 2016. tinyurl.com/y78tdluj. © The Mac Observer, 
Inc. Jim is a photographer and technology enthusiast based in 
ArlingtonVA. He has professional experience with both Windows- 
and Mac-based systems and networks. 

iPhone 7 Financing for Fun and Profit 
By Jim Tanous 
When Apple launched the original iPhone back in 2007, the 
company’s customers had one option for purchasing the 
revolutionary device: walk into an Apple Retail or Cingular/AT&T 
Wireless store, sign a 2-year service contract, and plop down at 
least $500. Now, on the eve of the iPhone 7 launch nine years later, 
iPhone customers have a variety of options when it comes to 
obtaining and paying for Apple’s latest flagship device. 


While today’s choice in iPhone purchase and financing options is 
certainly better than the early days of AT&T exclusivity, the number 
and complexity of choices can be a bit overwhelming. We’ve 
therefore set out to explain the various iPhone 7 financing options 
with the aim of helping you make your purchasing decision. 


Although the iPhone is more popular than ever internationally, note 
that we’re only looking at U.S. prices and carriers. See below for 
an overview  of each iPhone 7 financing option, with a 
handy summary chart at the end. 


Apple iPhone Upgrade Program 
First introduced in 2015 alongside the launch of the iPhone 6s, 
Apple’s iPhone Upgrade Program is unique among the other 
options below in that it includes AppleCare+ protection. This 
means that you end up paying more, both on a monthly basis and 
overall, but the total cost works out to that of a full-priced phone 
and AppleCare+ ($129), spread out over the payment period with 
zero interest. 


Customers in the iPhone Upgrade Program sign up for a 24-month 
agreement, financed through Apple by Citizens One Bank. This 
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gets you an unlocked model of the  latest iPhone of your 
choice and two years of AppleCare+ protection. If you make all 24 
payments, you’ll own the phone outright. After a minimum of 6 
months and 12 payments, however, you can trade your iPhone in 
to Apple, re-enroll for another two years in the Upgrade Program, 
and receive that year’s latest iPhone. This arrangement mirrors 
some of the carrier plans and is why Apple advertises its program 
with the “get a new iPhone every year” slogan. 


Monthly prices for the Apple iPhone Upgrade Program start at 
$32.41 for the 32GB iPhone 7 (total cost of $777.84, plus sales tax) 
and reach $45.75 for the 256GB iPhone 7 Plus (total cost: 

$1,098.00). One thing to note about Apple’s program, which also 
applies to many of the carrier options, is that you’ll need to pay the 
sales tax on the total cost up front in your initial payment, so keep 
that in mind when budgeting. Also remember that despite Apple’s 
user-friendly facade, the Upgrade Program is a financial agreement 
subject to credit checks and interest penalties should you fail to 
make timely payments. Check out the Program’s terms and 
conditions for the complete details. 


Apple iPhone Installment Plan 
For those looking for a slightly cheaper and simpler option, the 
Apple iPhone Installment Plan may be the answer. You’re still 
dealing directly with Apple in this option, but without the yearly 

upgrade and AppleCare+ aspects. 


Basically, Apple is offering customers zero-interest financing 
(again, through Citizens One) on the full retail price of the iPhone. 
You’ll get the same unlocked iPhone 7 model of your choice and 
make 24 monthly payments that equal the full retail price, plus 
sales tax. As with the iPhone Upgrade Program, you’ll pay the full 
sales tax up front. 


iPhone Installments are a good option for those who just want the 
iPhone hardware and are ineligible for carrier subsidies. No 
wireless service contracts, no dealing with carrier salespeople, just 
the full price of the phone spread out over two years. Monthly 
prices range from  $27.04 for the 32GB iPhone 7 (total cost: 
$648.96) to $40.37 for the 256GB iPhone 7 Plus (total cost: 
$968.88). 


Verizon Wireless 
Big Red no longer offers traditional subsidies and has now moved 
to zero-interest payment plans and trade-in credits. For both new 
and existing customers, Verizon offers virtually the  same zero-
interest financing terms for the 7 as the Apple Installment Plan. For 
the 32GB 7, that’s $27.08 per month for 24 months (which works 
out to $649.92), while on the other end of the spectrum the 256GB 
iPhone7 Plus will run you $40.41 per month (total cost: $969.84).


Keep in mind that these prices are just for the phone itself. You’ll 
still need to tack on a Verizon service plan to actually use the 
thing. And, just like all of the other financing options, you’ll need to 
pay the full sales tax up front. In Verizon’s favor compared to the 
other carrier options is that the iPhone is unlocked, so that’s one 
less thing to worry about if you want to sell or jump ship down the 
road.


For customers who already own certain models, Verizon offers a 
trade-in option worth up to $650. Those with an iPhone 6, iPhone 
6 Plus, iPhone 6s, or iPhone 6s Plus can opt to trade their working 
and good-condition device in to Verizon when purchasing a new 7. 
The carrier will then credit your account $27.08 per month for 24 
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months. For the 32GB iPhone 7, this covers the cost of your phone 
over the two year payment plan, minus taxes and interest (which 
makes the total package worth far less than $650 from the 
customer’s perspective). For higher end models, this acts as a 
subsidy on your monthly payments.


The key factor for the Verizon trade-in program, however, is that 
you must maintain service with the company for 24 months. If you 
switch to another carrier after, say, 12 months, Verizon won’t pay 
out the remainder of what it owes you on the trade-in. Therefore, 
only go this route if you’re sure that you’ll stick with Verizon for the 
long haul. Otherwise, you’re better off selling your existing iPhone 
on your own and using the cash to offset the cost of your upfront 
or monthly payments.


Finally, Verizon offers something similar to Apple’s iPhone Upgrade 
Program with its Annual Upgrade Program. Customers with select 
recent smartphones (iPhone 6s and newer, Samsung  Galaxy Note 
7* and Galaxy S7), can trade their devices in after a minimum of 30 
days and 50 percent payment and re-up with a new device and 
new agreement. This isn’t an entirely clean transaction, however, 
as you’ll need to pay upgrade and activation fees for the new 
device.


*If it’s not on fire.


AT&T 
AT&T was the first major carrier to move away from traditional 
subsidies, and they continue along that path with “Next” and “Next 
Every Year” options for the iPhone 7.


AT&T Next is based on a 30-payment schedule, so the monthly 
costs will be lower, but users will need to make at least 24 of those 
payments to upgrade. Like the other financing options presented 
here, there’s no interest if all payments are made in a timely 
manner. If you like the standard Next plan but don’t want to wait 
two years, you also have the option to make a down payment to 
both lower your monthly payment and become eligible for 
an upgrade sooner.


Monthly prices for AT&T Next plans range from $21.67* for the 
32GB iPhone 7 (total cost: $649.99) to $32.34* for the 256GB 
iPhone 7 Plus ($969.99), plus taxes which, again, are paid upfront.


AT&T Next Every Year is similar to the financing options from Apple 
and Verizon. Customers agree to 24 monthly payments, and can 
trade-in and re-up after only 12 months. Next Every Year prices 
range from $27.09 per month for the 32GB iPhone 7 ($649.99) to 
$40.42 per month for the 256GB iPhone 7 Plus ($969.99), plus 
taxes.


Like Verizon’s plans, you’ll need to maintain service with the 
company in order to keep your interest-free monthly payment 
schedule. Should you cancel or switch to another carrier, you’ll be 
required to immediately pay the balance of the phone’s price. Also 
like Verizon, AT&T is offering the same $650 trade-in option for 
select iPhones (iPhone 6 or 6s), with the value paid back to the 
customer in the form of 24 monthly credits.


*For AT&T and T-Mobile, the final monthly payment is slightly lower 
to bring the total cost to exactly the retail price of the phone.


T-Mobile 

The magenta “Uncarrier” has long offered unique service options 
compared to its competitors, and that continues with the financing 
options for the iPhone 7. T-Mobile’s financing plan charges 
customers the same monthly amount for all models of iPhone 7 
($27.09) and iPhone 7 Plus ($32.09), with the difference between 
the capacities being a down payment ranging from $99.99 (128GB 
iPhone 7) to $249.99 (256GB iPhone 7 Plus). The entry-level 32GB 
iPhone 7 requires no down payment. This keeps your monthly bill 
simpler and easier to calculate, especially for those with multiple 
devices on a single account.


In addition to the down payment option, users with an existing 
iPhone can trade in their device for 24-months of bill credits, 
similar to AT&T and Verizon’s offerings. The iPhone 6 and 6s are 
worth $649.99 ($27.09 per month), making the 32GB iPhone 7 
“free,” while those with an iPhone 5, 5c, 5s, or SE can get up to 
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$399.99 ($16.66 per month) to defray some of the iPhone 7’s cost. 
Like the other carriers’ plans, you must remain a T-Mobile 
customer throughout the 24-month financing period to receive the 
full value of your trade-in, and if you cancel early you’ll be required 
to pay the balance on your iPhone 7.


In terms of upgrade plans, T-Mobile’s “Jump” and “Jump On 
Demand” plans offer the same basic package as those from AT&T 
and Verizon, but with some interesting differences. For the basic 
24-month “Jump” plan, users can upgrade once 50 percent of 
their financed device has been paid off, while “Jump On 
Demand”  lets customers upgrade at any time, up to three times 
per year, during the 18-month payment plan. Jump On Demand 
also waives any upgrade fees, which are normally $20 a pop.


Sprint 

Rounding out the major carriers is Sprint, which offers the same 
basic zero-interest financing as its competitors, along with a trade-

in option which equates to monthly bill credits. However, the 
carrier still advertises a traditional contract subsidy option. With a 
2-year service agreement, customers can get the 32GB iPhone 7 
for $199.99, while the highest end 256GB iPhone 7 Plus will run 
you $519.99.


In terms of the no-contract financing options, Sprint offers its 
upgradeable “lease” plans ranging from 18-months at $26.39 for 
the 32GB iPhone 7 ($475.02) to 17-months at $47.00 for the 
256GB iPhone 7 Plus ($799.00). The trade-off with Sprint’s lease is 
that you get lower monthly and overall payments but you don’t get 
to keep the device at the end of the term (you’re expected to re-up 
and upgrade to the latest iPhone at that time). If you prefer keep-it-
at-the-end installments, Sprint has those, too, at the same prices 
as T-Mobile and AT&T (ranging from $27.09 to $32.09 per month).


Finally, Sprint has matched its competitors with a limited-time 
trade-in offer that will credit you up to $650 over the course of a 
24-month financing plan. Sprint customers interested in this offer 
will need to visit a Sprint store, however, to trade in their existing 
iPhone 6 or newer.


iPhone 7 Financing Summary 
It’s clear from the overviews above that all of the carriers, with a 
few exceptions, offer the same basic zero-interest deals when it 
comes to the iPhone 7. So let’s put it all together in a handy chart 
to highlight the few differences, based on the 32GB iPhone 7:


With iPhone 7 financing options practically identical across the 
major carriers, the most important factor becomes terms and 
service. As long as you have decent credit and make your 
payments on time, you’re going to end up paying the retail price 
for the iPhone 7 under most plans, so the only questions are how 
long you want to make your payments, when you want to upgrade, 
and who you want to deal with.


All of the carriers will generally charge activation or upgrade fees 
when you bring an iPhone onto their networks, even if you buy the 
phone directly from Apple. Some carriers, like Sprint, are offering 
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limited time activation fee waivers, and other carriers may waive 
the fees if you’re coming from another carrier or are persuasive 
enough. At $20 to $30 each, the amount and timing of activation 
fees is definitely something to consider.


A final consideration is carrier lock status of your iPhone. Both of 
Apple’s financing options and Verizon’s option give you an 
unlocked phone right out of the box, while all other iPhones will 
ship locked to their respective carriers. This may make it easier for 
you if you’re not sure which network you want to end up with when 
you order your iPhone 7, but customers can always unlock their 
iPhones down the road for resale or use on another network. Be 
sure to note, however, that the iPhone 7 isn’t “universal.” Unlocked 
iPhones ordered for AT&T and T-Mobile won’t be able to work with 
C D M A n e t w o r k s . T h e Ve r i z o n a n d S p r i n t m o d e l s , 
however, are compatible with GSM networks, so be sure to plan 
accordingly.


Is Apple the Best Option? 
With overall iPhone 7 prices pretty much the same across the 
board, it seems that going with one of the Apple plans is the best 
choice. After all, why not deal directly with a company known for 
good customer service instead of one from an industry notorious 
for terrible service? In reality, the answer may not be so simple.


Apple’s iPhone Upgrade and Installment plans are still very new, 
and the company is still facing growing pains related to the 
programs. Specifically, it seems that Apple failed to reserve 
enough supply to ensure that upgrade-eligible customers who 
signed up last year could choose their desired model when the 
iPhone 7 launched last week. Despite attempts by the company to 
address customer concerns, Apple is already facing a class action 
lawsuit over the issue.


While it’s easy to chalk this controversy up to high demand, a more 
cynical possibility is that Apple doesn’t need to ensure adequate 
supply at launch for its iPhone Upgrade customers, because those 
customers are committed to a two-year financing agreement and 

have no choice. Why “waste” available units on customers who 
are contractually obligated to keep making their monthly payments 
when those same iPhones could bring new customers into the 
fold? After all, those upgrade customers will get their iPhone 7’s 
eventually.


That’s not to say that this is some fiendish scheme by Apple, but 
the fact is that Apple has no real incentive to serve its iPhone 
upgrade customers while the carriers do. Therefore, you may have 
better luck securing your preferred iPhone model via your wireless 
carrier rather than Apple itself.


Another issue is the aforementioned upgrade and activation fees. 
Some carriers run promotions in which these fees are waived or 
reduced, and it’s always worth a shot to try and negotiate a waiver 
with the carrier’s salespeople. If you buy a phone from Apple, 
however, you’re definitely going to be paying those fees when you 
go to activate it on one of the wireless networks.


All of that said, it’s good to see a competitive iPhone 7 financing 
option from Apple, and hopefully the company’s management of 
the program gets better over time. But don’t overlook the carrier 
options entirely.
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JH Rogers posted the following article to ipadInsight.com on May 
22, 2017. tinyurl.com/kvej4gn. © iPad Insight. He is a confessed 
gadget hound for year and writes for AppleAtTheCore, iPadInsight, 
and iPhoneInsight 

First Impressions of Apple’s AirPods 
By J.H. Rogers  

I was finally able to get my hands 
on a pair of Apple’s latest hard to 
find hit. If you are still looking for a 
set of AirPods without the three to 
four week wait, keep an eye on 
AT&T, website. When they get 
them in stock, they process the 
orders quickly and have free 
shipping in the US. I got mine two 
business days after ordering, so I 
was happy with the experience, 
and was glad to not have to pay a 
premium or wait a month to get 
them.


Rather than doing a full review of the AirPods, I am just going to 
share some ongoing impressions of them over the next few weeks. 
I usually take my time when doing a product review anyway, as I 
like to really live with something for a bit before I do a full write-up 
on it. It takes time to really get the full measure of product, whether 
it be a device or an accessory. This way, I can share the little bits 
and pieces and impressions as they come.


The fit is perfect on me, but that experience isn’t 
shared by all

I have never had any issues with Apple’s EarPods, so I figured the 
AirPods would fit much the same. However, when you put down 
$150 instead of getting a headset free in the box with your phone, 
the stakes and expectations are definitely higher. My expectations 

on this point were actually exceeded a bit. Today was the first 
workday that I had them, so I used one as my Bluetooth headset 
for the day. It was comfortable and light enough to pretty much 
forget it was there.


Unfortunately, if EarPods don’t work for you, the AirPods likely 
won’t, either. They fit poorly on my wife to the point that they 
would barely stay in her ears. Considering the exclusive 
positioning of the AirPods in Apple’s lineup, it would be smart on 
their part to find some way to mitigate these issues with some 
interchangeable shapes or different sizes in future versions. I know 
there are parallel products from Beats, but none of them are fully 
wireless like the AirPods.


The battery life is acceptable, but the recharging case 
and the interchangeable nature of the AirPods 
overcomes any weakness

I can’t say the battery life of the AirPods is great. The single right-
side bud just BARELY made it though the work day for me today, 
so they aren’t as practical as a pure Bluetooth headset for phone 
calls. My Plantronics that I’ve used for the last two years lasts for 
several days on a charge, but it’s just a mono headset for phone 
calls so it isn’t an apples to apples comparison. All that said, I 
think the battery life is just fine for a first generation version of a 
fully wireless set of buds like these and it should only improve in 
future versions.


While the battery life of the earbuds is just good, the battery case 
really covers over any issues or potential dissatisfaction, at least 
on my part. Over the weekend I was using the AirPods more 
sporadically to listen to music, and I loved that every time I put the 
buds back in the case they quickly recharged to 100%. I know 
Apple wasn’t the first to use this recharging case design, but as 
usual, they have perfected it.


The design of the case is perfect

Plenty of hay has been made at the expense of the design of the 
AirPods, but I don’t have any objections to it. However, the praise 
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of the design of the AirPods recharging case has been almost as 
universal, and for good reason. From the smooth rounded corners, 
to the balanced hinge and magnetic closure of the lid with an 
unmistakable “click” on closure, to the magnetic seating of the 
AirPods for charging, it is a quintessential Apple design.


The sound quality is good, and that’s good enough

I’m not going to say that the AirPods deliver audiophile-quality 
sound. However, when you balance the sound quality with the 
convenience of fully wireless earbuds, they come out looking and 
sounding pretty solid. In my opinion, they do sound better than 
Apple’s more basic EarPods, and are much better than any 
inexpensive Bluetooth stereo headset that I have tried. The bass 
isn’t as pronounced as many listeners might like today, but I 
personally found the balanced nature of the sound to be a positive.


The controls are simple. Maybe a little too simple

I like the double-tap on the side of the AirPod mechanic to trigger 
Siri or to Play/Pause your music or podcast. It works very well. 
Unfortunately, there just isn’t enough control available without 
getting out your phone or going to your Watch (if applicable). I can 
understand having to choose between using Siri or Play/Pause 
when using one AirPod. However, I would love to see Apple 
expand on this, and allow separate controls on each AirPod to 
make use a little easier.


Using Siri with the AirPods is great…..but

Siri does work very well with the AirPods. I found recognition to be 
more accurate than with my iPhone in crowded or noisy areas. 
Like the Watch, its mic seems to be tuned to recognize voice 
queries. However, unlike the Watch, you don’t have to put anything 
closer to your mouth to get this good recognition. I’m glad to see 
Apple putting in some effort on getting good voice recognition, 
and it gives me hope that the coming Siri speaker will be another 
step in the right direction.


Using Siri with the AirPods is smooth, but there is room for 
improvement in the future. At first, I was disappointed that “Hey 
Siri” didn’t work on them, but I can understand that keeping the 
mic enabled at all times would put a huge strain on the already 
limited battery capacity. However, as battery capacity and life 
improves in future versions of the AirPods, this could be a killer 
feature. It would allow for hands-free voice queries, and also would 
open up the tap control possibilities since Siri wouldn’t have to be 
triggered to be used.


I would fight people in line to get a set of AirPods in 
Black

I like the classic Apple “iDevice White,” and all. However, the case 
and the buds are going to show dirt and wear a lot more  with that 
bright white surface. I have already cleaned the inside of the case 
a couple of times. The white AirPods also are very conspicuous 
when you’re wearing them. I would much prefer an official black 
set from Apple, as they will be less likely to show dirt and wear, 
and will be far less conspicuous when in use. I have no doubt we 
will see these in a year or two.


That’s enough for round one. After a few days of use, I know I 
won’t be sending the AirPods back, as I have been very pleased 
with them overall. As such, I will keep posting about my 
experience with them as time goes on. Also, if any of you have any 
specific questions about the AirPods, let me know and I will try to 
get you an answer. Feel free to post any thoughts in the 
Comments below, on Flipboard, on our Facebook page, or on 
Twitter @iPadInsightBlog. 


�27

https://www.facebook.com/iPad-Insight-205087269524101/?ref=bookmarks
https://mobile.twitter.com/iPadInsightBlog


                 VOLUME 28, NUMBER 6                    MAIN LINE MACINTOSH USERS GROUP                   JUNE 2017 

The following article was posted to castleink.com on February 17, 
2014. tinyurl.com/y8bov3c6.


How to Save Ink? Try Grayscale Printing & More 
When it comes to purchasing a printer, the 
price represents only a portion of the cost. 
You must consider the price you originally 
pay for the printer itself as well as the 
expense of buying ink cartridges every 
time the printer's ink runs out. If you own a 
business that requires a lot of printing or if 
you print a lot of photos, ink cartridges may 
frequently need to be replaced. These 
extra costs can add up in a hurry, but 

luckily there are ways you can save money by making your ink 
cartridges last just a little longer. 

Top 10 Tips for Making an Ink Cartridge 
Last Longer 
1. Print only what you absolutely need
Before you start printing any particular portion of text or graphics, 
decide its relevance and usefulness so that you do not 
unnecessarily spend time in printing things that may not be of much 
use. In short, you should print only those things that you may 
actually need to save consumption of considerable amounts of ink. 

Additionally, these days you can find free programs online such as 
CutePDF that will allow you to turn almost anything into a PDF. 
Once a document is a PDF, then it can be uploaded to an online 
cloud storage service such as Dropbox, Box.com (yes, it's 
different), or Google Drive. All of these have mobile apps, so you 
will still have access to documents wherever you are.  
2. Use Print Preview
Print Preview is a useful function that shows you how the document 
will look after it has been printed. It can help you adjust spaces and 

decide which pages to print. Consider turning off the color ink 
cartridges, selecting only the text you require and only the pages 
you need - especially that last page with the footer that comes out 
with each print job. This can significantly reduce your printer ink 
usage as well as your paper usage. 

3. Print text over graphics
If you are printing documents only for later reference, print only the 
essential text and any related images or graphics that are required. 
Avoid printing images or colorful graphics if having a hard copy is 
not essential to the purpose of the document. 

4. Print in Draft mode as often as possible
Use draft print quality whenever you can. Go to File - Print to open 
the box that lists the settings for your printer. Click 'Properties' to 
bring up the various options available. You'll probably find different 
choices under the heading 'Paper/Quality' that allow you to select 
draft quality printing. Your document will print at a lower resolution 
but that may not matter for reference material that you will likely 
discard later. You can always switch to a higher resolution for a final 
version of a document. 

5. Grayscale Printing: Print text in black ink only
Print documents that are in black and white with a black ink 
cartridge. Choose black and white printing over color whenever 
possible. Depending on your printer, you may have the option to 
select grayscale printing using the black ink cartridge only. What is 
grayscale printing? It's simply printing using your black ink 
cartridge to produce print that is a combination of gray tones 
between black and white only. If you print black with a color ink 
cartridge, various colors are mixed to create the black ink. Not 
using grayscale depletes your color ink cartridge a lot faster than it 
would deplete a black ink cartridge. If you're not doing presentation 
quality work, or if you're printing text only, chances are you won't 
need the other colors.  

6. Use color ink only when needed
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If you want your refilled ink to run longer, then make use of color 
printing only when it is required. Otherwise, for general and regular 
use, it is wiser to use black and white printing that helps in saving 
your money on buying additional refills. 

Modern personal printers can produce high quality photographs, 
particularly if you use specialty photo paper. But printing high 
quality digital shots can use a lot of ink, so if you print a large 
number of photos you might want to outsource your photo printing 
to a local print center. Many services allow you to order your prints 
online. You can also have your photos printed on calendars, mouse 
pads or greeting cards if you wish. 

7. Keep your printer nozzles clean
Perhaps the easiest change you can make to your printing habits is 
to keep an eye on your printer heads. The printer ink nozzles that 
dispense the actual ink use a spray function to get the ink onto the 
paper. As such, these nozzles can experience a build-up of dried 
ink and become clogged. Clean the nozzle heads every few weeks 
or more often if you're a heavy printer. 

If a color cartridge isn't printing all the colors, remove the cartridge 
and wipe the bottom of it where the ink comes out firmly with a 
damp paper towel or lint-free cloth to unclog the nozzle. This will 
help the ink flow more freely from the cartridge. 

8. Use all the ink in the cartridge
Continue to print even when your printer light comes on or you get 
a warning saying that your ink is low. Check the ink level in the 
cartridge and if it appears that there is some ink left, keep using it 
instead of changing the cartridge immediately. There is likely quite 
a bit of ink left in the cartridge; remember that the ink comes out in 
a spray so it doesn't take much per page. Use it all and then shake 
the ink cartridge to break up any ink clogs (especially in humid 
climates). You may get hundreds of extra pages out of a cartridge 
by doing this. Keep printing until the ink is almost completely gone 

(but be careful that you don't run the printer with an empty 
cartridge). 

9. Select "Printer-Friendly" Pages when printing from the Web
You would be surprised how much ink is wasted by printing pages 
directly as they appear from a website. One Web page can have 
multiple pictures or graphics...not to mention several pages worth 
of printing because Web pages are typically much longer than a 
regular document. Opt for the printer-friendly option if you need to 
print something from the Web. This eliminates all the unnecessary 
images, and will save your ink cartridges as well as your printing 
paper. 

10. Use the printer regularly
If you don't print very often, you can stretch the life of your inkjet 
cartridges by keeping the printer moving. Print a page or two at 
least once a week using both your color and black ink cartridges. 
You can print something small (even a printer diagnostic test) to 
prevent the ink from drying up. 

Another ink-saving tip is to power down your printer the right way 
after each use. Don't merely switch it off or unplug it, but allow your 
printer to power down slowly and shut itself down. The print heads 
need to be in the right position while the printer is turned off to 
prevent the ink from drying up prematurely. The printer should also 
be covered when not in use. 
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Melissa Holt posted the following article to macobserver.com on 
December 28, 2016. tinyurl.com/yayxyhhh. © The Mac Observer, 
Inc. She is an Apple Consultant who lives and works along the 
Front Range in Colorado. 

Merging Calendars 
By Melissa Holt 
Back in the long long ago, I wrote a tip about how to merge 
calendars on your Mac  if you want to clean stuff up. That was all 
fine and good, but now there’s an easier way to do it! So if you’ve 
got a long list of duplicate or outdated calendars to sort through, 
this’ll make it much simpler. 


As always, please make sure you back up your calendars before 
you do any major clean-ups, all right? You can do this by either 
backing up the individual calendars one at a time or by choosing 
File > Export > Calendar Archive, which’ll back up everything in 
one big lump. I actually suggest doing both things; I’m a fan of 
redundancy, as you probably know if you’ve read pretty much 
anything I’ve written. 


Once you’re finished backing up, then, all you have to do is click 
on the “Calendars” button in the program’s toolbar to reveal the 
sidebar list if it’s not already showing…


…and then right- or Control-click on the calendar you’d like to 
merge into another.


As you can see, that’ll bring up a “Merge” choice for you to pick 
which calendar you’d like to move the original’s events into, so be 
sure to choose the right one! The Calendar app will then warn you 
of what’s about to happen.


So, pay attention! The calendar you right-clicked on will have all of 
its events moved into the second one you chose, and then the 
original calendar will be deleted. As that dialog box notes, you 
can’t undo this, so be sure that’s what you want. (And if you 
ignored my backup warnings, you can pick “Export” here to make 
a copy of the soon-to-be-deleted calendar if necessary.) 


When you’re sure you’re ready, click “Merge” from that dialog box, 
and all of the old calendar’s events will be moved. This is just so 
much faster and easier than the previous steps we had to walk 
through! I’m a little more jazzed than the situation probably 
warrants. I, uh, think I need to sit down now. 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Gary Rosenzweig posted the following article to macmost.com on 
May 19, 2017. tinyurl.com/yd7ck3jl. © CleverMedia, Inc. He is the 
producer and host of MacMost, published 30 books on the iPad, 
Macs, and programming, & created more than 250 games. 

Making Numbers Formulas Easier To Read 
By Gary Rosenzweig 
You can use a trick to force a line return in Numbers formulas so 
they are easier to read and edit. The same trick can be used in 
some web forms and other apps to add line returns when a regular 
Return keystroke doesn't work.


To view the video, go to   tinyurl.com/yd7ck3jl


Video Transcript 
So here's a handy little tip if you use Numbers a lot. Especially if 
you use complex long formulas in Numbers. You'd get things that 
look like this. If I click here and look at the formula it gets to be 
pretty long and this is actually a pretty short one. It could go for 
several lines of really complex nested ands and ifs and all sorts of 
things in here. 


Here I've got a simple formula, more or less, where I'm multiplying 
the quantity times a price here in this lookup table. So I'm taking 
the product name and using that in lookup to lookup based on the 
product , the price. So apple matches to apple here which gives 
me the price of 25 cents. So it's the quantity times 25 cents and 
then I multiply that by an IF statement, if there's a check in this 
checkbox, this discount column I've got .75 (in other words 75% 
of the price) or 1 if there's no checkmark there. In other words a 
25% discount if I check on that. So I can test this out by checking 
it and you can see I get 25% discount here. I can change the price 
of apples to say 26 cents and you can see all the apple prices 
updated a little bit. 


So that's all great and it works fine except that when I go to edit 
this formula it gets a little long. It would be nice to be able to break 
this up on lines. It turns out you can. If you put your cursor 

somewhere where you want to break a line and you hit Return, of 
course, it's just going to enter the formula. But instead if you were 
to hit Option, Return it actually puts a line there. So I'm going to do 
that before and after the multiplier there. I'm going to do it before 
that after the multiplier here. Now you can see it's a lot easier for 
me to understand what's going on in this formula. 


All I need to do now is copy, paste that over all of these, it's the 
same formula as the one line version but now it's in all of them. 
Anytime I go to look at that formula there I can see it's broken up 
on multiple lines. The short version of the formula is down at the 
bottom. That's not going to show those line breaks because there 
is only room for one line there. But when I'm actually working on 
the formula I get this break up here. 


You know the Option Return is a very useful thing. You can use it 
on a lot of different occasions. For instance, a lot of sites with 
forms for filling something in like little chat windows and things like 
that. They automatically submit what your typing if you hit Return. 
But if you hit Option Return it actually puts a line return there and 
you can break up what you're saying on multiple lines. 


So it's kind of a handy thing to try out. It works here in Numbers 
and it works in a variety of other places. It certainly makes for a lot 
nicer looking formula.  
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The following article was posted to cableorgamizer.com. 
tinyurl.com/ya3aor5g. © CableOrgamizer.com, LLC. 

What Is The Difference Between Cat 5, Cat 5e, and 
Cat 6 Cable? 
Untangling the Mystery! 
So, let's say you want to play one of those new-fangled gaming 
console devices I've heard so much about, or you just want to 
connect to that Interweb.net that all the hip youngsters can't stop 
gabbing about. Well, you'll need some type of cable, right? (Spoiler 
alert: Right.)

In your magical Quest to Find the Right Cable (soon to be a trilogy 
directed by Peter Jackson), you'll likely come across Cat 5, Cat 5e, 
and Cat 6 cables with no clue as to what these designations mean. 
Perhaps these cables are the tails of felines, and the number 
denotes how many of their nine lives remain? Nonsense, why 
would you even think that? The truth is that any of these cables 
will hook you up with a connection, but there are important 
distinctions to keep in mind when choosing which one may be 
right for you. So here's the lowdown...


CAT5 
Cat 5 is the slowpoke of the bunch. It 
can handle 10/100 Mbps speeds 
(Fast Ethernet) at up to 100 MHz 
bandwidth. That's a lot of numbers, 
but what it means is "slow and 
obsolete". New installations don't 
even use it, and it's on its way out, 
sadly...that's sadly for the cable, not 
for you. For the savvy cab le 
connoisseur there are newer, better, 
faster, stronger options out there. 
That's why we at CableOrganizer.com 
do not sell Cat 5 cable and we don't 
advise you to buy them. That is, if you 
can even find any...like at a garage sale or something, maybe.


CAT5e 
Cat 5e (Cat 5 enhanced) is currently the 
most commonly used in new installations. 
It's designed to greatly reduce crosstalk. If 
you just read that and then nodded while 
slowly saying "Yeah...crosstalk..." don't 
worry, that's why you're here: to learn! It 
basically means the Cat 5e is better at 
keeping signals on different circuits or 
channels from interfering with each other. A 
step above Cat 5, it can handle 1000 Mbps 
speeds (gigabit Ethernet) at 100 MHz. 


CAT6 
Category 6 is a major improvement over Cat 5e. It's really just the 
bee's knees. It's suitable for up to 10 gigabit Ethernet at 250 MHz. 
To even better tackle the issue of that 
pesky crosstalkin', Cat 6 cable has an 
internal separator that isolates pairs 
from one another. For those who want to 
"future-proof" their residential or 
commercial network as much as 
possible without a significant cost 
increase, Cat 6 is a great choice. That 
doesn't mean it'll protect your network 
from cyborgs from the future or 
anything, it just means it will keep it up 
to date for longer when the "next big 
thing" comes along 

Hopefully, this brief guide helped you get to know your Cat cables. 
If you'd like to thank us, just go ahead and check out our selection 
of products. After all, we're one of the largest cabling, cable 
management, and networking resellers in the world! If you require 
further assistance, please feel free to give us a call at 
1-866-222-0030. We have a friendly and highly knowledgeable 
staff standing by! Want to know more about Cat 6 and Cat6a? 
Check out our explainer.  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Daniel Nations posted the following article to lifewire.com on May 
4, 2017. tinyurl.com/yb8fjfp2 © About.Inc. He has been writing, 
programming and following technology since back in the 
Commodore Vic 20 days. 

What Is AirDrop? 
By Daniel Nations 
AirDrop is a feature that lets Macs and iOS devices share files 
wirelessly with a minimum of fuss.


AirDrop is extremely cool and useful, but unfortunately, it is one of 
those features most people don't know about not because it is 
hard to use -- it isn't -- but because most people don't think to 
look for it.  AirDrop makes sharing files, especially photos, much 
easier.  But most of the time when we want to share a photo with 
someone, we just send it to them in a text message.    Which is 
easy enough, but when that someone is standing right beside you, 
it is even easier to simply use AirDrop.


AirDrop isn't just for photos, of course.  You can use it to transfer 
almost anything that you can share.  For example, you can AirDrop 
an website from your iPad to your friend's phone, which is great if 
they want to bookmark to read later.   Or what about a grocery list? 
  You can Airdrop text from Notes to someone else's iPad or 
iPhone.   You can AirDrop anything from a playlist to a location 
you've pinned in Apple Maps.    Want to share your contact 
information?  AirDrop it. 


How Does AirDrop Work? 
AirDrop uses Bluetooth to create a peer-to-peer Wi-Fi network 
between the devices. Each device creates a firewall around the 
connection and files are sent encrypted, which actually makes it 
safer than transferring via email. AirDrop will automatically detect 
nearby supported devices, and the devices only need to be close 
enough to establish a good Wi-Fi connection, making it possible to 
share files across several rooms. 


One advantage to AirDrop is the use of Wi-Fi to make the 

connection.


Some apps provide a similar file sharing capability using 
Bluetooth. And some Android devices use a combination of Near 
Field Communications (NFC) and Bluetooth to share files. But both 
Bluetooth and NFC are relatively slow compared Wi-Fi, which 
makes sharing larger files using AirDrop much faster and more 
convenient. 


AirDrop Supported Devices: 
AirDrop is supported on the iPad 4, iPad Mini, iPhone 5 and iPod 
Touch 5 and newer devices including the iPad Air and iPad Pro 
models. It is also supported on Macs with OS X Lion, although 
Macs released earlier than 2010 may not be supported.


How to Turn On AirDrop 
Having trouble finding out where to turn on AirDrop? If you have 
found yourself hunting through your iPad's settings, you are 
looking in the wrong place. Apple wanted to make it easy to turn 
AirDrop on or off, so they put the setting in the new control panel. 
Unfortunately, this isn't the first place all of us look for turning 
on settings.


You can access the new control panel by sliding up from the 
bottom of your iPad's screen. Remember, you need to start at the 
very edge. You can even start completely off the iPad's display if 
that helps.


Find Out More About the Control Panel 
Once the control panel is revealed, you will have access to the 
AirDrop settings. You can turn it on, off or "contacts only", which is 
the default setting. 'Contacts Only'  means only people in your 
contacts list will be allowed to send you an AirDrop request.


How to Use AirDrop on the iPad 
You will need to be near the person you are sharing with and they 
must have their device turned on for it to register, however, you 
need not be right next to them. AirDrop can even reach into the 
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next room. Both devices will also need the correct permissions to 
AirDrop with each other.  


In the Control Panel you can tap the AirDrop button to turn 
permissions from "Off" to "Contacts Only" to "Everyone."    It's 
usually best to leave it at "Contacts Only."


You will also need to navigate to whatever you want to share. So if 
you want to share a web page, you'll need to be on that web page. 
If you want to share a photo, you'll need to be viewing that photo 
in the Photos app. AirDrop is not a file manager like what you 
might see on a PC. It's designed to share what you are doing at 
that time.


• First, tap the share button. This is the box with the arrow 
sticking straight up. This share button accesses the Share menu, 
which allows you to share via AirDrop, Facebook, iMessage, etc. 
View a picture of the share button.


 

• Next, locate the device you want to receive your AirDrop. 
This is the top portion of the Share menu. Devices will show up 
as a circle with an identifying label under it. This will be the 
contact's photo with their name under it, but if you don't have a 
photo attached to this contact, it will show up as a gray circle 
with their initials in it.


• Last, tap the circle. Tapping will initiate sending the document 
to the recipient, who will then be prompted whether or not to 
accept the AirDrop.


That's it. You can drop anything from photos to web pages. You 
can even share a contact by tapping the Share Contact button at 
the end of the contact's information in the contacts app.
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The following article was posted by Jeff Butts to MacObserver.com 
on April 27, 2017. tinyurl.com/y754rdof. © The Mac Observer Inc. 
He is pursuing a master’s in Computer and Information Systems, 
but he’s been working on computers since before he ever thought 
about teaching. 

Use Google Without Tracking in StartPage 
By Jeff Butts 
I might have found my new favorite search engine. I like 
DuckDuckGo for its privacy, but folks have raised concerns about 
its US-based location. I’m also not happy that it doesn’t actually 
deliver Google search results. Instead, it serves up its own.  

StartPage, on the other hand, delivers actual Google search results 
in absolute privacy. It’s Google without tracking. They do this by 
submitting your query to Google stripped of identifying 
information. You even get a free proxy with every result. So, you 
can visit a third-party website without your internet service 
provider knowing about it. Even better, StartPage doesn’t track 
your searches or log your IP address. It’s such a privacy-minded 
search engine  that it consistently meets or exceeds the 
requirements of EuroPriSe. Even Edward Snowden recommended 
it. Plus, StartPage  offers many of the same tools as a normal 
Google search. This includes refining  your results to only show 
images or videos. If a search engine can be sexy, this one sure is. 


�35

MEMBER 
GETS 

PASTED

http://www.apple.com
http://www.duckduckgo.com/
http://www.startpage.com/
https://www.startpage.com/eng/protect-privacy.html#hmb
https://www.startpage.com/eng/protect-privacy.html#hmb
https://www.youtube.com/watch?v=7_RnBX3l124
https://www.youtube.com/watch?v=7_RnBX3l124


                 VOLUME 28, NUMBER 6                    MAIN LINE MACINTOSH USERS GROUP                   JUNE 2017 

Sandro Cuccia posted the following article to macobserver.com on 
May 4, 2013.tinyurl.com/jwb2hb3. © The Mac Observer Inc. He 
has been using and supporting Macintosh since 1984 and is now 
an independent Mac consultant, speaker, writer, and educator, after 
an extensive IT career at a major chemical company. 

How to Effectively Use the Notes App in iOS & OS X 
By Sandro Cuccia 
The Notes app. It's been around since day-one in the life of iOS. 
The Mac version is now available for Mountain Lion, and it's fully 
iCloud-compliant. This isn't the word processor you're looking for. 
It's a skeuomorphic yellow legal pad for taking notes.


To me, prior to Mountain Lion, iOS 6 and iCloud integration, the 
Notes app was useless. Yes, I could keep "local" notations on my 
iPhone or iPad if I wanted to. Yes, there was primitive syncing 
available. However, since there was no Notes app available on the 
Mac, synced notes ended up in the Mail app. 


No, thanks.


The Notes app has now done a one-eighty with the introduction of 
Mountain Lion, iOS 6 and iCloud. All of a sudden I find the Notes 
ecosystem to be simple, yet immensely useful. Let's take a look.


First, in order for the syncing via iCloud to work, the syncing 
service for Notes needs to be enabled on the Mac and iDevices. 
When you first configure your iCloud account on all your devices, 
you are given the opportunity to turn on iCloud syncing for Notes 
as well as other apps. Ultimately, you can enable or disable Notes 
syncing at any time.


Mac OS X Configuration for Notes Integration with iCloud


On the Mac, starting with Mountain Lion, Notes syncing is enabled 
by going to System Preferences > iCloud and enabling Notes via 
the checkbox provided. 


Enable Notes iCloud Syncing on the Mac via the iCloud 
Preferences Pane. 

iOS Configuration for Notes Integration with iCloud 
In iOS, go to Settings > Mail, Contacts, Calendars > [tap on 
your email account]. In the configuration panel of the selected 
email account, you will find all the switches for activating iCloud 
syncing for a number of apps, including Notes. 
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Notes Integration via iCloud: a Wonderful Thing. 
If you have configured Notes on all your devices to sync with the 
same iCloud account, your notes are seamlessly synchronized. For 
all practical purposes, this happens instantaneously – assuming 
there exists a wireless or cellular data connection. If you are out of 
range, things will sync up nicely once a connection is re-
established.


Notes on the Mac has some basic data organization features. 
Using Notes, you can create a note and add an image or a file to it 
by drag-and-dropping, you can delete notes, and you can share 
notes via email or messaging.


You select notes to view via the sidebar. You can open a note in a 
separate window by double-clicking the note in the sidebar. 
Occasionally, I like to "float" a note on the desktop by going to 
Window > Float on Top. The floater can be dragged around the 
screen. Sorting can be done via View > Sort By. 


Your notes are stored in containers the app calls "folders", 
corresponding to one or more email accounts you have configured 
your device with. To enable viewing notes from other accounts, go 
to Notes > Accounts. 


You can also create folders to visually organize your notes. If you 
don't see the folders list to the left of the sidebar, click on the 
Show Folders List icon at the bottom of the sidebar. 


To display notes from a specific folder, select a folder. To display all 
notes in an account, select the "All" folder for that account, such 
as All iCloud. To display all notes in all accounts, select All Notes 
at the top of the list. 


To create a folder, choose File > New Folder. If All Notes is 
selected in the folders list, the folder is created in the default 
account. Otherwise, it's created in the account of the current 
folder. 


Renaming and deleting folders can be done by right-clicking the 
folder and making a selection from the popup menu. Pay attention 
to any alerts that may come up.


Moving notes and folders is intuitive. Move a folder you created by 
dragging it to another account. To create a subfolder, drag the 
folder onto another folder that you created. Move a note to a 
different folder by dragging it from the sidebar onto a folder. To 
copy a note, hold the Option key while you drag the note. 


Some text formatting is supported in Notes. Simply select the text 
you want to format, and then make a choice from the Format 
menu. Bulleted, dashed and numbered lists are also supported via 
Format > Lists.  


Using Notes in iOS 
Pretty much everything works the same way when running Notes 
in iOS.
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On the iPhone, Notes functionality is spread across several 
screens.  

A couple of considerations to brief you on:


In the iOS version of Notes, you can set a default font via Settings 
> Notes. I happen to be one of three people in North America who 
like Marker Felt. (Hey, I happen to like Comic Sans on the Mac; 
gimme a break!) You also have Noteworthy and Helvetica to 
choose from. On the Mac side, you can set other fonts via Format 
> Fonts > Show Fonts, but anything other than the three default 
fonts will be substituted when syncing to iOS.  


Notes can default to one of three fonts. For apps that support 
large text, system-wide size settings can be set in the Accessibility 
Settings Panel


If you want to set a larger-than-default text size (I like 20 points), 
go to Settings > General > Accessibility > Large Text, and make 
your selection. 


To search in Notes on iOS, keep in mind the search field may be 
hidden from view. While viewing the list of notes, scroll to the top 
of the list, by swiping downward, to reveal the search field. Tap in 

the field and type the text you’re looking for. By the way, you can 
also search for notes from the Home screen.


Finally, for any Mac-based notes which contain attached images or 
files, the attachments do not currently synchronize over to iOS; 
just the note and a little paperclip icon to represent the non-
existent attachment.


In conclusion, Notes really works quite well and is all you need if 
you want is a simple, built-in solution for synchronizing notes 
among all your devices as well as some rudimentary storage and 
organization features.


Although Notes is highly practical to me, I would like to see at least 
two enhancements: export options (other than cut-and-paste) and 
multiple note printing. I don't mind the yellow legal pad with the 
realistic tiny-paper-tearing-thingies-at-the-top-of-the-pad, but it 
would be nice to be able to choose from a variety of paper 
designs.


Why not give Notes a good two or three day workout on all your 
devices. Once everything is configured to sync properly, you may 
just be surprised at how simple and useful the Notes/iCloud 
ecosystem can be.


Did you know?… 
There is an Easter Egg in Notes. If you can get a magnified view of 
the the icon for the Notes app, you will see that the scribbling 
shown on the notepad is a tribute to the ancient but famous "The 
Crazy Ones" Apple TV ad from the late nineties – part of the "Think 
Different" ad campaign. The text reads: 


"Here’s to the crazy ones. 
The misfits. The rebels. 
The troublemakers. 
The round pegs in the square holes. 
The ones who see things different. 
They’re not fond of rules, 
and they have no respect for the status quo." 
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Bob LeVitus posted the following article to macobserver.com in 
2017. tinyurl.com/ydb4kh3r. © The Mac Observer. Bob is the 
author of more than 80 books, a computer columnist, and Mac 
expert. He writes a weekly column for The Mac Observer and is 
one of my favorite authors and speakers. 

Taking Notes in macOS Sierra 
By Bob LeVitus  
Notes is an electronic notepad for your Mac. A note is a 
convenient place to jot quick notes, recipes, phone numbers, or 
whatever. Some notes are shown here. 


Notes is for making notes on your Mac. 

To create a new note, choose File → New Note; press ⌘+N; or click 
the button with the little square and pencil in the toolbar. 

Notes is supremely flexible; here are just a few things you can do:


• Double-click a note to open it in its own window so you 
can drag it around onscreen by its title bar.


After opening a note in its own window, if you want the note to 
float in front of other windows so it’s always visible, choose 
Window → Float on Top. 

• Change text to any font, color, size, and style by selecting it 
and using the myriad of tools in the Format menu.


• Search for a word or phrase in any note by typing your 
query in the Search box.


• Create bulleted, numbered, or dashed lists by selecting 
the text and choosing Format → Font → Lists.


• Create folders to organize your notes by choosing File → 
New Folder, pressing ⌘+Shift+N, or clicking the New Folder 
button at the bottom of the Folder list.


The Notes window must be selected to create a new folder. If a 
note in a window is active, the New Folder command will be 
unavailable. So click the main Notes window if the New Folder 
command is grayed out. Or click the New Note button in the 
toolbar, which is enabled even when working with a note in a 
separate window. 

Folders in the Notes application are exclusive to Notes. In other 
words, the folders described in the following bullets aren’t 
folders in the Finder. You won’t find them on your hard disk; 
they live only in the Notes app (and iCloud or other Internet 
accounts if you’ve enabled them). And also remember that 
folders are strictly optional. If you don’t have a ton of notes, 
keeping them all in a single folder and using the Search box to 
filter them may work for you. 

�39

http://macobserver.com
http://tinyurl.com/ydb4kh3r


                 VOLUME 28, NUMBER 6                    MAIN LINE MACINTOSH USERS GROUP                   JUNE 2017 

• Show or hide the Folders list by choosing View →  Show/
Hide Folders or clicking the Show/Hide Folders button in the 
toolbar.


• Show only Notes in a folder by clicking the folder name in 
the Folders list, or click All iCloud to see all your notes.


• Automatically sync notes with your iDevice by using 
iCloud or other Internet Accounts by choosing Notes  → 
Accounts, which will open the Internet Accounts System 
Preferences pane; then click the appropriate Internet account — 
such as Office 365 or Gmail — and enable its check box to sync 
Notes.


•	 Send the contents of a Note via the Mail or Messages apps 
by choosing File → Share or clicking the Share icon.


• Print a note by choosing File → Print or pressing ⌘+P.


Whatever you type in a note is saved automatically as you type 
it, so Notes has no Save, Save As, or Duplicate commands. 

Other Notes goodies include a spell checker, spoken notes, text 
substitutions (such as Smart Quotes and Smart Dashes), and 
transformations (such as Make Upper or Lowercase). You can find 
all these options on the Edit menu.


Moving right along, El Capitan introduced four new features in 
Notes:


•	 You can drag and drop photos, PDFs, videos, and other 
files into a note, something that wasn’t possible in Notes prior to El 
Capitan (10.11).


•	 The Attachments browser displays every external file you’ve 
dragged into every note in a single place, making it easier to find 
things. Click the Attachments button in the toolbar to see this 
feature in action; click the Attachments button again to go back to 
your notes.


•	 Use the Share menu in apps such as Safari and Maps to 

add content to Notes.


•	 You can add checklists (in addition to bulleted, numbered, 
and dashed lists), as shown in the to-do list in the middle, by 
clicking the Checklist button in the toolbar, by choosing Format → 
Checklist, or by using the shortcut ⌘+Shift+L.

New in Sierra is the ability to share notes with others and allow 
them to edit them. Here’s how it works: Click the Add People 
button in the toolbar and choose how you’d like to send your 
invitation: Mail, Messages, Twitter, Facebook, AirDrop, or Linked 
In.

If the person you invite is also running Sierra, she’ll see the note in 
her copy of Notes; if they’re running any other operating system, the 
note will open in the iCloud website for editing. When she’s done, 
you’ll see her edits in Notes on your Mac within a few minutes.

You now know everything you need to know to use and enjoy 
Sierra’s new, beefed-up Notes app!
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Tom Nelson posted the following article to lifewire.com on March 
6, 2017. tinyurl.com/yc59ctj9. © About, Inc. He is a consultant and 
writer providing Macintosh training, advice, and support. He has 
written hundreds of articles, tutorials, and product reviews. 

Using the Mac Security Preference Pane 
By Tom Nelson  
1. Mac Security - Using the Mac Security Preference 
Pane 

The Security preference pane allows you to control the security 
level of the user accounts on your Mac. Computer: iStock

The Security preference pane allows you to control the security 
level of the user accounts on your Mac. In addition, the Security 
preference pane is where you configure your Mac's firewall, as well 
as turn data encryption on or off for your user account. 


The Security preference pane is divided into three sections. 


General: Controls password usage, specifically, whether 
passwords are required for certain activities. Controls automatic 
log-out of a user account. Lets you specify whether location-
based services have access to your Mac's location data. 


FileVault: Controls data encryption for your home folder, and all of 

your user data. 


Firewall: Allows you to enable or disable your Mac's built-in 
firewall, as well as configure the various firewall settings. 


Let's get started with configuring the security settings for your 
Mac. 


Launch the Security Preference Pane 
Click the System Preferences icon in the Dock or select 'System 
Preferences' from the Apple menu. 


Click the Security icon in the Personal section of the System 
Preferences window. 


Proceed to the next page to learn about the General configuration 
options. 


2. Using the Mac Security Preference Pane - General 
Mac Security Settings 
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The General section of the Security preference pane controls a 
number of basic but important security settings for your Mac.

The Mac Security preference pane has three tabs along the top of 
the window. Select the General tab to get started with configuring 
your Mac's general security settings. 


The General section of the Security preference pane controls a 
number of basic but important security settings for your Mac. In 
this guide, we will show you what each setting does, and how to 
make changes to the settings. You can then decide if you need the 
security enhancements available from the Security preference 
pane. 


If you share your Mac with others, or your Mac is located in a 
place where others can easily gain access to it, you may wish to 
make some changes to these settings. 


General Mac Security Settings 
Before you can begin making changes, you must first authenticate 
your identity with your Mac. 


Click the lock icon in the bottom left-hand corner of the Security 
preference pane. 


You will be prompted for an administrator username and 
password. Provide the requested information, and then click OK. 


The lock icon will change to an unlocked state. You're now ready 
to make any changes you wish. 


Require password: If you place a check mark here, then you (or 
anyone who attempts to use your Mac) will be required to provide 
the password for the currently account in order to exit sleep or an 
active screen saver. This is a good basic security measure that can 
keep prying eyes from seeing what you're currently working on, or 
accessing your user account data. 


If you select this option, you can then use the drop-down menu to 
select a time interval before the password is required. I suggest 
selecting an interval long enough that you can exit a sleep or 

screen saver session that starts unexpectedly, without needing to 
provide a password. Five seconds or 1 minute are good choices. 


Disable automatic login: This option requires users to authenticate 
their identity with their password anytime they log on. 


Require a password to unlock each System Preferences pane: 
With this option selected, users must provide their account ID and 
password anytime they attempt to make a change to any secure 
system preference. Normally, the first authentication unlocks all 
secure system preferences. 


Log out after xx minutes of inactivity: This option lets you select a 
set amount of idle time after which the currently logged-in account 
will be automatically logged out. 


Use secure virtual memory: Selecting this option will force any 
RAM data written to your hard drive to be first encrypted. This 
applies to both virtual memory usage and Sleep mode when the 
contents of RAM are written to your hard drive. 


Disable Location Services: Selecting this option will prevent your 
Mac from providing location data to any application that requests 
the information. 


Click the Reset Warnings button to remove location data already in 
use by applications. 


Disable remote control infrared receiver: If your Mac is equipped 
with an IR receiver, this option will turn the receiver off, preventing 
any IR device from sending commands to your Mac. 


3. Using the Mac Security Preference Pane - FileVault 
Settings 
FileVault can be very handy for those with portable Macs who are 

concerned about loss or theft. 
FileVault uses a 128-bit (AES-128) encryption scheme to protect 
your user data from prying eyes. Encrypting your home folder 
makes it nearly impossible for anyone to access any user data on 
your Mac without your account name and password. 
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FileVault can be very handy for those with portable Macs who are 
concerned about loss or theft. When FileVault is enabled, your 
home folder becomes an encrypted disk image that is mounted for 
access after you log in. When you log off, shut down, or sleep, the 
home folder image is unmounted and is no longer available. 


When you first enable FileVault, you may find the encryption 
process can take a very long time. Your Mac is converting all of 
your home folder data into the encrypted disk image. Once the 
encryption process is complete, your Mac will encrypt and decrypt 
individual files as needed, on the fly. This results in only a very 
slight performance penalty, one that you will rarely notice except 
when accessing very large files. 


To change FileVault's settings, select the FileVault tab in the 
Security Preferences pane. 


Configuring FileVault

Before you can begin making changes, you must first authenticate 
your identity with your Mac. 


Click the lock icon in the bottom left-hand corner of the Security 
preference pane. 


You will be prompted for an administrator username and 
password. Provide the requested information, and then click OK. 


The lock icon will change to an unlocked state. You're now ready 
to make any changes you wish. 


Set Master Password: The master password is a fail-safe. It allows 
you to reset your user password in the event you forget your login 
information. However, if you forget both your user account 
password and the master password, you will not be able to access 
your user data.


Turn On FileVault: This will enable the FileVault encryption system 
for your user account. You will be asked for your account 
password and then given the following options: 


Use secure erase: This option overwrites the data when you empty 

the trash. This ensures that the trashed data is not easily 
recoverable. 


Use secure virtual memory: Selecting this option will force any 
RAM data written to your hard drive to be first encrypted. 


When you turn FileVault on, you will be logged out while your Mac 
encrypts your home folder's data. This can take quite a while, 
depending on the size of your home folder. 


Once the encryption process is complete, your Mac will display 
the login screen, where you can provide your account password to 
log in. 


4 Using the Mac Security Preference Pane - 
Configuring Your Mac's Firewall 

The application firewall makes it easier to configure the firewall 
settings. Instead of needing to know which ports and protocols are 
necessary, you can just specify which applications have the right to 

make incoming or outgoing connection. 
Your Mac includes a personal firewall you can use to prevent 
network or Internet connections. The Mac's firewall is based on a 
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standard UNIX firewall called ipfw. This is a good, though basic, 
packet-filtering firewall. To this basic firewall Apple adds a socket-
filtering system, also known as an application firewall. The 
application firewall makes it easier to configure the firewall 
settings. Instead of needing to know which ports and protocols are 
necessary, you can just specify which applications have the right 
to make incoming or outgoing connections. 


To begin, select the Firewall tab in the Security preference pane. 


Configuring the Mac's Firewall 
Before you can begin making changes, you must first authenticate 
your identity with your Mac. 


Click the lock icon in the bottom left-hand corner of the Security 
preference pane. 


You will be prompted for an administrator username and 
password. Provide the requested information, and then click OK. 


The lock icon will change to an unlocked state. You're now ready 
to make any changes you wish. 


Start: This button will start the Mac's firewall. Once the firewall has 
been started, the Start button will change to a Stop button. 


Advanced: Clicking this button will allow you to set the options for 
the Mac's firewall. The Advanced button is only enabled when the 
firewall is turned on. 


Advanced Options 
Block all incoming connections: Selecting this option will cause 
the firewall to prevent any incoming connections to non-essential 
services. Essential services as defined by Apple are: 


Configd: Allows DHCP and other network configuration services to 
occur. 


mDNSResponder: Allows the Bonjour protocol to function. 


raccoon: Allows IPSec (Internet Protocol Security) to function. 


If you choose to block all incoming connections, then most file, 
screen, and print sharing services will no longer function. 


Automatically allow signed software to receive incoming 
connections: When selected, this option will automatically add 
securely signed software applications to the list of applications 
that are allowed to accept connections from an external network, 
including the Internet. 


You can manually add applications to the firewall's application 
filter list using the plus (+) button. Likewise, you can remove 
applications from the list using the minus (-) button. 


Enable stealth mode: When enabled, this setting will prevent your 
Mac from responding to traffic queries from the network. This will 
make your Mac appear to be non-existent on a network. 
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The following article was posted by Zack Whittaker to zdnet.com 
on September 13, 2016. tinyurl.com/yd98fott. © CBS Interactive. A 
criminologist, he is a journalist, writer and broadcaster who has 
been cited by a wide range of publications, including CNN, the 
Huffington Post and AllThingsDigital. 

Five Security Settings In iOS 10 You Should 
Immediately Change 
These tweaks will lock down your iPhone or iPad to protect your 
privacy. 

By Zack Whittaker  
The latest version of Apple's mobile operating system comes with 
some privacy improvements. Before you do anything like 
customizing your phone, loading new apps, or syncing your data 
for the first time, you should take a few steps to lock down your 
device and protect your privacy.

Here are the important tweaks to get you started.


1. Check for data-leaking widgets 
The first thing you might notice are widgets, which give you an at-

a-glance view of your day (where you're going, the news, your 
calendar, what's coming up next, and more). This swipe-right 
feature is available from your lock screen.


Notice anything that shouldn't be there? Check those data-leaking 
widgets by unlocking your iPhone, then swiping right to the 
widgets panel, and scrolling down. From there, select edit, and 
that's where you can modify what's displayed on the lock screen. 


2. Lock down your location 
Like previous versions, iOS 10 tracks where you go -- so long as 
you connect to wi-fi while you're there, such as a workplace, bar, 
coffee shop, or home. You can stop your phone or tablet from 
recording your "frequent locations" by going to Settings > Privacy 
> Location Services > System Services and then Frequent 
Locations. Once you're there, turn the option off. For extra 
privacy, hit the Clear History button. 
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3. Limit what your locked device can do 




We've seen numerous cases before of the lock screen opening up 
opportunities for attackers to take control of your device or swipe 
data. You should prevent others from using Siri or being able to 
reply to your text messages.


By going once again to Settings > Touch ID & Passcode, you can 
limit what is available on your lock screen. For maximum privacy, 
all items should be disabled. But you can customize this 
depending on your preferences. You can also enable the Erase 
Data function so that your device erases its storage after 10 failed 

unlock attempts. 


4. Lower your auto-lock timeout 




The shorter the lock screen setting, the faster your iPhone or iPad 
display will shut off before anybody can get access to it. You can 
lower the auto-lock period by going to Settings > Display & 
Brightness > Auto-Lock. Remember: lower is better.  
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5. Rein in your notifications 




Just like previous versions of iOS, you can set your alerts and 
notifications to preview their content -- like text messages and 
emails -- on your lock screen, allowing anyone with access to your 
iPhone or iPad a glimpse. To limit this feature, for example, to just 

showing the sender of the message, go to Settings > 
Notifications, and then select Messages and Mail for text 
messages and email, respectively. From each screen, you can 
change the preview style. For maximum privacy, disable Show 
Previews so that message content won't be displayed on the lock 
screen.  
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Sam Costello posted the following article to lifewire.com on April 
10, 2017. tinyurl.com/ydbw3mrj. © About.com. He is a consultant 
and writer providing Macintosh training, advice, and support since 
the Mac Plus. He has written hundreds of articles, tutorials, and 
product reviews. 

7 Tips to Improve iPhone Security 
By Sam Costello  

When we talk about  iPhone security, we're not talking about quite 
the same thing as security on a desktop or laptop computer. Sure, 
everyone wants to keep their data safe from people who they don't 
want to have access to it , but tradit ional computer 
security  concerns like anti-virus software aren't really issues for 
iPhone and iPod touch owners.


Perhaps the most pressing concern when it comes to iPhone 
security isn't electronic, but physical: theft. 


Apple's devices are attractive targets for thieves and are often 
stolen; so much so that as much as 18% of grand larcenies in New 
York City involve iPhone theft. 


But just because theft is a major concern doesn't mean it's the 
only aspect of iPhone security you should care about. What 
follows are some tips that every iPhone and iPod touch user 

should follow:


1. Prevent Theft 
With theft being the biggest security threat to iPhone users, you 
need to take steps to keep your iPhone safe and make sure it 
stays yours. Check out these anti-theft tips for ideas on how to 
stay safe. 


2. Set a Passcode  
If your iPhone is stolen, you better make sure that the thief can't 
access your data. One of the best, and easiest, ways to that is my 
turning on your iPhone's built-in Passcode feature. Learn more 
about the Passcode, including how to set one and what it controls. 
You can set a passcode after its stolen using Find My iPhone 
(more on that in a minute), but it's better to get in the good security 
habit ahead of time. 


3. Use Touch ID 
If your device sports Apple's Touch ID fingerprint scanner (as of 
this writing, that means the iPhone 7 series, iPhone 6 and 6S 
series, SE, and 5S, as well as both iPad Pro models, iPad Air 2 and 
iPad mini 3 and 4), you should use it. Having to scan your 
fingerprint to unlock your device is much stronger security than a 
four-digit passcode that you can forget or that can be guessed by 
a computer with enough time. 


4. Enable Find My iPhone 
If your iPhone does get stolen, Find My iPhone may be the way 
you get it back. This free feature of iCloud uses the phone's built-
in GPS to pinpoint its location on a map so you (or, much safer and 
better, the police) can track it to its current location. It's a great 
tool for finding lost devices, too. Here's what you need to know 
when it comes to Find My iPhone: 


5. Antivirus Software 
Antivirus software is a core part of how we secure desktop and 
laptop PCs, but you don't hear too much about iPhones getting 
viruses. But does that mean that it's safe to skip using antivirus on 
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an iPhone? The answer, right now, is yes. 


6. Don't Jailbreak Your Phone 
A lot of people advocate jailbreaking your phone because it allows 
you to customize your smartphone in ways not approved by Apple 
and install apps that have been rejected for inclusion in the official 
App Store. But if you want your iPhone to be as secure as 
possible, stay far away from jailbreaking. 


Apple has designed the iOS—the operating system that runs on 
the iPhone—with security in mind, so iPhones aren't subject to 
viruses, malware, or other software-based security threats 
common to PCs and Android phones. 


Except for jailbroken phones. The only viruses that have struck 
iPhones have targeted jailbroken devices, for instance. So, the lure 
of jailbreaking may be strong, but if security is import, don't do it. 


7. Encrypt Backups 
If you sync your iPhone with your computer, the data from your 
phone is also stored on your desktop or laptop. That means that 
the data is potentially accessible by people who can get at your 
computer.  Secure that data by  encrypting those  backups. This 
prevents someone who doesn’t know your password from getting 
access to your data by using your computer.


Do this in iTunes when you sync your iPhone or iPod touch. On the 
main sync page, in the Options section below the picture of your 
device, you’ll see a checkbox called Encrypt iPhone backup or 
Encrypt iPod backup. 


 Check that box and set a password for the backup. Now, if you 
want to restore from that backup, you’ll need to know the 
password. Otherwise, no getting at that data.


Optional: Security Apps 
There aren’t a lot of apps that will improve your iPod touch or 
iPhone security right now—though that may change in the future. 


As iPhone security becomes a bigger issue, expect to see things 

like VPN clients and antivirus suites for the iPhone or iPod touch. 
When you do see them, though, be skeptical. Apple's design for 
the iOS is very different than, say, Microsoft's for Windows and it's 
much more secure. Security is unlikely to become as big a 
problem on iOS as it is on other OSes.


It’s also important to note that some tools available at the App 
Store that appear to perform heavy-duty security functions—like 
fingerprint or eye scans—don’t actually perform those tests. 
Instead, they use another security protocol that they disguise by 
appearing to perform those scans. Before you buy security apps at 
the App Store, make sure you’re clear on what the app does and 
doesn’t do. 
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Software Review: ChronoSync 4.7.3 
Test System: Mac Mini running Sierra 10.12.5

Price: $49.99/$24.99

Company: Econ Technologies, Inc. 

URL: www.econtechnologies.com

System requirement: macOS 10.8 & later

Reviewer: Stan Horwitz


ChronoSync provides functionality that is difficult to find in the 
Mac world; an application that synchronize a pair of folders. 
ChronoSync does that and much more.


Why would you want to synchronize a pair of folders? Suppose 
you have a Mac laptop and a Mac desktop. Like many people, you 
primarily work on your documents on your laptop, but you also 
want your documents be saved to your desktop so you work them 
on your desktop and ensure they’re backed up. 


If you keep all your documents in a folder called “in progress,” for 
example, you can have ChronoSync synchronize its contents 
between your two Macs. This is different than a conventional 
backup. With synchronization, if you work on a document on your 
laptop, it will be copied to your desktop for you or vise versa.


I installed ChronoSync on my Mac mini, in my home office. I set it 
up to synchronize a folder called “important stuff” on my DropBox 
cloud disk. In this folder, I keep bank statements and my budget 
spreadsheet. I have my DropBox disk mounted on my Mac mini 
and my MacBook Pro. I can use ChronoSync to copy any new files 
from my “important stuff” folder on my DropBox disk to a 
corresponding “important stuff” folder on my Mac mini’s external 
disk drive.


Suppose I update my budget spreadsheet on my laptop. The 
updated spreadsheet file will be synchronized by DropBox so it is 
visible to my Mac mini, then ChronoSync will see your synchronize 
my “important stuff” folder on my Mac mini’s external disk drive.


C h r o n o S y n c i s a v a i l a b l e f o r d o w n l o a d a t 
www.econtechnologies.com. The full version costs $49.99. An 

express version costs $24.99. See the website for information on 
the two versions and the optional features. Free technical support 
and updates are available to users who purchase ChronoSync.


Installing ChronoSync is a breeze! The installer is a 44MB DMG 
file, which contains an installer, an uninstaller, a quick reference 
guide, and a link to detailed online documentation.


Starting ChronoSync for the first time shows a window that offers 
the opportunity to register it or use it on a free 15-day trial.


The synchronization feature is easy to set up. ChronoSync can 
only synchronize one pair of folders at a time, but ChronoSync can 
keep a predefined collection of folders in sync. It can also 
synchronize files on your iOS devices.


ChronoSync can also clone hard drives and do backups. 
ChronoSync is configured with the ChronoSync dashboard. The 
dashboard and the configuration controls are intuitive.


Configuring ChronoSync is easy. You can have it either do 
traditional synchronizing, or you can have it keep multiple copies 
of your documents. There are numerous options on how to 
configure ChronoSync. I chose the most basic options. You can 
also set up ChronoSync to sync on a daily schedule.


Synchronizing is fast! I barely had time to blink before it finished 
synchronizing roughly 45 files in my “important stuff” folder the 
first time.


I like ChronoSync for its well designed dashboard, easily 
configured options, and its speed. I give it 5 out of 5 apples. 
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J. D. Biersdorfer posted the following article to the nytimes.com on 
September 12, 2016. tinyurl.com/ybp362lr.  © The New York Times 
Company. She is a member of the newsroom technology staff at 
the Times. 

Put Your Signature on the Digital Dotted Line 
By J.D. Biersdorfer 

Sign your name in the box, tap the Done button and drag your 
signature into place.  

Q. Is it possible to sign a PDF using an iPad? 


A. With an update to the Mail app in last year’s iOS 9 software, 
Apple added a Markup tool for annotating PDF files sent as 
attachments. If you are not sending the documents by email, third-
party apps like Adobe Acrobat Reader, Evernote and many others 
also let you sign and annotate PDF files on iOS devices and other 
platforms (like Android). 


If you need to sign a PDF file attached to a Mail message, first 
press and hold the attachment icon until the box of sharing 
options appears on the screen. If you are sending the attachment 
yourself, tap the Markup icon. If you have been sent the PDF and 
merely want to digitally sign it and return it to the sender, tap the 
Markup and Reply icon. A copy of the file will appear on the 
screen.


Once you enter Markup mode, a new toolbar appears along the 
bottom of the PDF file. By tapping the various tools, you can write 
or draw on the document, zoom in on sections, type in text — or 
add a digital version of your signature to drag into place on the 
appropriate line of a form.


To add your John (or Jane) Hancock to the file, tap the Signature 
icon near the middle of the toolbar. In the box that appears, sign 
your name with your fingertip, Apple Pencil or other compatible 
iPad stylus. When you have finished, your signature will appear in 
a floating box on the screen that you can drag into place on the 
document. Tap the Done button in the corner of the window when 
you have finished annotating the file and want to send it along in 
its updated state.
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Jason Snell posted the following article to macworld.com on May 
25, 2017. tinyurl.com/keotg7h. © Mac Publishing, LLC. Jason has 
been a technology writer for more than 20 years and has a 
Master's degree in journalism. He was Macworld Editorial Director. 

How iCloud Photo Library Matches Up To Google 
Photos 
By Jason Snell 
Google announced major additions to Google Photos at I/O 2017. 
Where do Photos and iCloud Photo Library have to catch up, and 
should we be looking for from Apple at WWDC?


Last week at the Google I/O developer conference, Google 
announced a raft of forthcoming additions to its Google Photos 
service. Since Google Photos runs on iOS and in any web browser, 
it’s a serious photo-storage option for Mac, iPhone, and iPad users
—and in many ways, it’s way ahead of Apple’s Photos apps and 
iCloud Photo Library service.


Then again, WWDC—Apple’s own developer conference—is in just 
two weeks. It’s an opportunity for Apple to declare where it’s 
taking Photos and iCloud Photo Library next. In the meantime, 
though, it’s worth pointing out where Google Photos is beating 
Apple’s offerings, and where Apple’s ahead—and how WWDC 
could be poised to change both sides of the equation.


Apple’s advantages 
I’ve spent an awful lot of time with Photos 
and iCloud Photo Library. You could say that I 
wrote the book on it, because I have. 
Spending that much time up close with any 
product makes you appreciate its features 
and deeply understand its flaws.


Photos and iCloud Photo Library seem to be 
knocked reflexively by Internet commentators and critics alike, 
which is unfortunate—it’s actually a pretty impressive collection of 
features that work quite well. Keep in mind that iCloud Photo 

Library and the overhauled Photos app for Mac are only a couple 
of years old, and that the machine-learning features that allow 
Photos to let you search for all your photos of cats or zebras was 
only introduced last fall. These are, in some ways, Apple’s baby 
steps with a new product.


Apple’s Photo offering has a few big advantages over Google 
Photos. If you’re a Mac user who prefers native apps to web apps, 
for example, Apple has a huge advantage—Photos is a real Mac 
application, while Google Photos runs entirely inside your web 
browser.


There’s also the matter of security. With Google Photos, your entire 
photo library is available on Google’s servers, to be processed and 
analyzed in whatever way Google sees fit. In contrast, images in 
iCloud Photo Library are encrypted and Apple can’t see them 
when they’re off your device. There are a lot of advantages to 
Google’s approach, which I’ll get to shortly, but if you’re someone 
who feels uneasy about giving Google access to your personal 
data, Google’s approach will be a huge turn-off.


Finally, iCloud Photo Library has an advantage on iOS that’s tied in 
to Apple’s status as the owner of the operating system. The 
Photos app can sync to iCloud Photo Library automatically, but 
third-party apps like Google Photos don’t have unlimited power to 
remain running in the background. Google Photos does its best to 
work around these limitations, but in my experience I can always 
count on my iCloud Photo Library to be properly synced with the 
latest changes in my library; with Google Photos, it’s a bit of a 
crapshoot.


Google’s advantages 
Though Google’s reliance on analyzing 
your photos in the cloud is a drawback if 
you’re concerned about privacy, it’s got a 
lot of advantages. First among them, your 
photos need only to be analyzed once—and using Google’s 
powerful server hardware. Apple’s approach with Photos requires 
that every image be scanned for potential keyword matches on 
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your device—which takes time and uses processor power, as 
many people discovered when they upgraded to iOS 10 or macOS 
Sierra last fall. What’s worse, the machine-learned keywords don’t 
sync via iCloud, so every device you use has to re-scan your entire 
library—a huge waste of time.


With any luck, the next versions of macOS and iOS will allow 
photo data to sync across devices, saving this step. But the larger 
issue remains: Google’s ability to scan (and re-scan) your photos in 
the cloud lets it work faster and improve scanning quality as it 
adjusts its algorithms.


Google also seems to have a head start on Apple when it comes 
to using machine learning; at the very least, the company has been 
quite vocal about how much it’s investing in its learning systems, 
while Apple’s been quieter on that front. However, I’m reluctant to 
claim that Google is destroying Apple in this area.


I just did some random spot checks on my photo library in both 
Google Photos and Apple’s Photos app: Both of them produce 
some impressive finds as well as some laughable misfires. Yes, if I 
search for dogs in Photos, I’ll get photos of cows and cats. But 
when I do the same search on Google Photos, guess what? Cats 
and pairie dogs. That’s the state of machine learning today—on 
both sides of the fence.


However, Google’s announcements last week show that it’s 
planning on leveraging what it learns about your photos in some 
clever new ways. The new suggested sharing feature will notice if 
people in your contacts list are present in photos you take, and 
ask if you want to share those photos with them. That’s a smart 
feature that Apple could implement, too—and is consistent with 
the Memories feature added to Photos last fall, which intelligently 
groups subjects and locations into collections.


Google Photos will soon be able to print photo books, which will 
not come as news to Photos and iPhoto users who have been able 
to do this for more than a decade. But the fact that Google will use 
metadata gleaned from scanning photos via machine learning in 
order to assemble the books is intriguing. Apple’s book- and 

calendar-creation tools have languished since the iPhoto days; 
maybe people would be more inclined to print books or photos if 
the same technology that powers Memories could be used to lay 
them out?


Google’s announcements at I/O included one that’s been on my 
mind in the two years since Apple introduced iCloud Photo Library: 
Sharing your library with a trusted partner. Though Apple has 
offered the ability to link iTunes accounts used by a family together 
for a while now, that feature is basically unconnected to iCloud 
Photo Library. (The one exception is a family shared album, which 
lets you manually choose to share photos—scaled down to three 
megapixels in size—with other family members.)


My wife and I have wanted to pool our photo libraries for ages now
—the alternative is for me to occasionally plug her iPhone into my 
Mac and import her photos, and for her to ask me to AirDrop 
photos I’ve taken to her when she wants to post them to 
Facebook. Google Photos will allow that now—and Apple needs to 
follow suit.


But, you’re saying to yourself, what if you want to share some but 
not all photos with a partner? Google’s announcement takes this 
extra step, letting you specify that certain sorts of photos—for 
example, photos of specific people—be shared, while others 
aren’t. While offering an all-or-nothing library sharing feature would 
be nice, it’s even better if sharing can have some granularity. 
Google’s headed there now. Will Apple follow?


Google’s added even more intelligence to something that was 
already a strength of Google Photos—intelligently analyzing your 
photos and suggesting ways to make them better. At I/O, the 
company demonstrated an editing tool that detected a chain-link 
fence between a camera and the subject and removed it 
automatically. Google Photos already will assemble animated GIFs 
out of a series of still photos, ready for sharing.


This sort of stuff is smart, because it offers new ways to enjoy and 
share our photos without requiring us to do extra work. That’s one 
of the next frontiers of photo technology—how do we take the tens 
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of thousands of photos in our libraries and the dozens more we 
shoot on a daily basis and do something with them? It’s too much 
for a person to wade through manually. We need intelligent 
assistants to help us do the job. Google and Apple are both 
heading there. I hope Apple’s still working hard on this front and 
we’ll find out more in June at WWDC.


Finally, one last note about where Apple’s behind: The cost of 
storage. Google offers unlimited free photo storage, though if 
you’ve got very large photos or videos, those items will be stored 
at a reduced resolution. If you pay extra to keep those large items  

at full resolution, Google’s cloud storage costs what Apple's does, 
but it's awfully hard to argue with free. Apple allowing families to 
share storage would be a positive step, as would offering a free 
tier that would allow a generous amount of iPhone backup and 
photo storage.


Apple’s photo offerings aren’t out of the game. It’s got some tough 
competition, but it’s been making strides of its own. Let’s hope 
that with iOS 11 and the next version of macOS, Apple’s approach 
to storing and sharing photos keeps getting better.
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